
Introducing Cyberjack

Navigating the Internet

Cyberjack makes navigating the Internet easy. Whether you have a specific task in mind, such as 
reading the latest postings to your favorite newsgroup, retrieving a file from an FTP site or sending 
email to a friend, or just want to explore all that the Internet offers, you can do them all using 
Cyberjack.

Cyberjack is a comprehensive set of Internet programs or “tools”—World Wide Web, newsgroups, 
IRC, Gopher, Archie, FTP, Finger and Ping—used to browse, retrieve and send information.

Using the Right Tool for the Task

There are many activities you can pursue on the Internet. To easily navigate the Internet, it is important 
to use the right Cyberjack program for the task. The Cyberwizard—the primary Cyberjack wizard—
directs you to the appropriate program based on the task you want to accomplish. You may also find 
the following table outlining activities and the corresponding Cyberjack programs useful.

To Perform This Task ... Use This Program ...

Browse Internet sites using an intuitive, visual 
interface. More commonly know as surfing the 
Net.

Cyberjack Web

Search for files and folders containing your 
specified search word in the name or contents.

Cyberjack Archie

Retrieve files from sites when you know the 
name of the file and the address of the site. 
Send files to sites to which you have access 
privileges.

Cyberjack FTP

Learn names and addresses of specific users 
at an Internet site, and determine if they are 
currently online.

Cyberjack Finger

Browse files and folders. Cyberjack Gopher

Participate in live keyboard conversations. Cyberjack IRC

Read messages posted to newsgroups, and 
post your own messages.

Cyberjack News

Using the Cyberwizard

The Cyberwizard presents Internet scenarios, such as “Surf the Net” and “Search for Info”. All you 
need to know is what activity you want to pursue. Clicking a scenario starts another wizard for the 
appropriate Cyberjack program.

The Cyberjack program wizard prompts you for information as it takes you through the required steps. 
When you finish the wizard, you have accomplished your task.

You can start any Cyberjack program wizard without going through the Cyberwizard.

Working With the Guidebook

The Guidebook organizes and simplifies your Cyberjack and Internet activities. The Guidebook 



contains entries called “CyberLinks”. A CyberLink contains a site address, and information about the 
Cyberjack program used to connect to that site. Double clicking a CyberLink connects you to the site.

The first time you open the Guidebook, you have the option of copying a collection of hundreds of 
CyberLinks to the Guidebook. You can start navigating the Internet immediately using these 
CyberLinks. You can also create your own CyberLinks as you discover other interesting sites, by 
clicking Save on the toolbar.

As well, if a site you are visiting contains other site or user addresses, you can save the information as 
a CyberLink without first connecting. Simply right click the address and paste it into your Guidebook.

At any time, connect to the Delrina server to update your Guidebook with new and interesting sites. 
Additional guidebooks are also available.

From the Guidebook toolbar, you can also start any of the Cyberjack programs.

Organizing CyberLinks

It is easy to organize CyberLinks using the Guidebook. You can create as many folders and subfolders 
as required to store the CyberLinks, and drag and drop CyberLinks between folders to reorganize the 
Guidebook to suit your requirements. The Guidebook has two display tabs—Alphabet and Type—that 
further organize CyberLinks. With both tab types active, CyberLinks are displayed alphabetically 
according to site type.

Integrating With Netscape Navigator

Whether you are currently using Netscape Navigator or are planning to do so in the future, you can 
integrate Cyberjack with Netscape Navigator. After integrating, you can start Cyberjack programs from 
within Netscape Navigator. For example, if you double click a Gopher site address while browsing with 
Netscape Navigator, Cyberjack Gopher starts and connects to the site.

To integrate Cyberjack with Netscape Navigator, click Netscape Integration on the Setup menu.

If you want to start Netscape Navigator when you click a Web CyberLink in the Guidebook, you must 
uninstall Cyberjack Web. If Netscape Navigator is not your default Web browser, then the default Web 
browser you have selected will start. To uninstall programs, see your Microsoft Windows 95 
documentation.

Notes

If you experience problems integrating with Netscape Navigator or using any of the Cyberjack 
programs with Navigator, make sure you are running the latest version of Netscape Navigator. You can 
download the latest version of Netscape Navigator by connecting to the following Web site:

http://home.netscape.com/
For Cyberjack to detect Netscape Navigator on your computer, you must have installed Navigator 

and run it at least once.
Netscape Navigator is a trademark of Netscape Communications, Inc.

Using In-Place Activation

As you explore the Internet, you will visit sites containing references to other sites you may want to 
visit immediately. You can use “in-place activation” to connect to these sites—double clicking an 
address starts the appropriate Cyberjack program (if the site is a different type than the one you are at) 
and makes the connection, without exiting the program you were using initially. For example, while 
visiting a Web page, double clicking a referenced FTP site address starts Cyberjack FTP and connects 
to the FTP site, but you do not exit Cyberjack Web. You can return to the previous site by clicking the 
Previous Page button.



Sending Email

If you are running Microsoft Exchange or any MAPI-compliant email program, you can send messages 
from Cyberjack to other users on the Internet. You can also start your email program from the 
Cyberjack Guidebook to check for any incoming messages.

To save connection charges, you can write email messages while off line, and send them when you 
connect to the Internet.



About third-party Internet links

Cyberjack may contain various links to third-party pages or sites. Delrina provides these links as a 
convenience to you. These sites are created by their respective owners and are not under the control 
of Delrina. Information on these sites is provided by their respective owners only.

Accordingly, Delrina can make no representation concerning the content of these sites to you, nor can 
the fact that Delrina has provided this link serve as an endorsement by Delrina of any of these sites. 
Delrina does not endorse or approve the use of any of the third-party product names or trademarks 
that may appear on these sites.

Delrina makes no warranties, express or implied, with respect to the information, products, and/or 
services described, nor any representations regarding the quality, safety or suitability of any freeware, 
shareware, demos or any other products, offers or services found on these sites. There are inherent 
dangers in the use of any freeware, shareware, demos or any other products, offers or services found 
on the Internet, and Delrina cautions you to make sure that you completely understand the risk before 
retrieving any software on the Internet.



System requirements

The following table outlines the minimum and recommended system configurations necessary to install 
and run Cyberjack.

In general, if you have installed Windows correctly, you have a compatible modem and you have 
enough disk space, you can install and run Cyberjack.

Equipment Minimum Recommended

Computer Any PC running 
Windows 95

486 or Pentium

Computer Memory 8 MB 16 MB or more

Modem Any TAPI-compatible 
modem

Any TAPI-compatible 
modem or a direct 
TCP/IP (LAN) connection

Graphics display VGA SVGA

Hard disk space 11.5 MB for the 
compact installation 
(includes WinComm), 
additional free space 
for data files

25 MB for the typical 
installation (includes 
WinComm), additional 
free space for data files

Printer Any supported by 
Windows 95

Laser printer

Mouse Any supported by 
Windows 95

Any supported by 
Windows 95

Email system Microsoft Exchange 
or any MAPI-
compliant email 
system

Microsoft Exchange

Operating system Windows 95 Windows 95



Understanding the Internet

Defining the Internet

The Internet is a worldwide collection of computer networks. When you connect to the Internet, you 
have access to an enormous collection of information, resources and services covering many areas of 
interest. You also become part of a global community of users including the government, military, 
educational institutions, business and, of course, other private citizens.

As the Internet evolved, a set of common programs or “tools” used to browse, retrieve and send 
information—such as World Wide Web, newsgroups, IRC, Gopher, Archie, FTP, Finger and Ping—also 
evolved to facilitate these activities. These tools give users a sense of connecting to a large, single 
network.

Since all kinds of computers with different operating systems (such as Windows, UNIX and Macintosh) 
are part of this vast network, information must often travel across diverse systems before reaching its 
destination. Thus, the Internet uses a set of signals, or communications protocol, that all networks and 
computers can understand and use to communicate with each other. This protocol is known as TCP/IP 
(Transmission Control Protocol/Internet Protocol).

A Brief History

The Internet traces its beginnings to a successful experiment that began in the late 1960s with the 
United States Department of Defense (DOD). ARPANET, a small network connecting four computers 
at different geographic locations, was created to exchange sensitive information between DOD staff 
and contractors, and universities conducting military research.

For the experiment to be successful, it was crucial that the network be able to reroute information if 
one of the computers went down, either by accident or enemy attack.

ARPANET was a success, and more computers were added. Users began to exchange more than 
military information. Defense workers quickly recognized how easy it was to exchange electronic mail
—now one of the most popular ways to use the Internet.

Recognizing its value, more universities wanted to be part of this network. To accommodate the 
demand, it was necessary to create two networks—MILNET which had the military sites and a smaller 
ARPANET which retained the academic and research sites. However, users were not restricted to 
exchanging information within their own network. Using the IP (Internet Protocol) communications 
protocol, the networks could route messages back and forth.

The National Science Foundation provided the funding for the research-oriented ARPANET, and it 
became known as NSFNET. In time, NSFNET connected regional networks, and was soon joined by 
several large commercial networks, providing direct connections to individual users.

From the beginning, the Internet has been an important vehicle for academics. This explains why so 
much of the information available on the Internet is academic and research oriented, although this is 
changing as increasing numbers of new users redefine the Internet to meet their needs and 
expectations.

Maintaining the Internet

Although many of the networks that are part of the Internet are owned by organizations, the Internet 
itself has no owner. The fact that the Internet offers international communication and access to 
information is largely due to the collaboration and voluntary efforts on the part of Internet advocates.

There is no single authority figure that governs the Internet. Several volunteer organizations, working 
together, are responsible for the technical management and future direction of the Internet. To be a 



part of the Internet, networks must adhere to the agreed-upon technical communications standards 
and protocols, or work with the various organizations to address and resolve concerns, and advocate 
change.

Of course, there is a cost associated with being a part of the Internet. Everyone pays according to their 
use or participation. For example, networks fund their interconnections, and corporations pay to 
connect to regional networks, which in turn pay access fees to service providers. When you connect 
through a service provider, part of your monthly connection charge is allocated to the costs associated 
with providing this Internet connection.

The Internet’s Growing Popularity

Given the wealth of global information found on the Internet, and the ability to communicate with 
people throughout the world, it is not surprising it has become a very popular way for people to pursue 
interests, and exchange and promote ideas. Users connect for many reasons, including business, 
research and recreational purposes.

A cultural shift in the type of information found on the Internet is occurring as new users redefine how 
the Internet is used. Commercial use has become more common, both to meet the needs of business 
and the individual. No doubt, this trend will continue as restrictions pertaining to what constitutes 
“appropriate usage” are relaxed.

Moderating the Internet

This surge in popularity has also resulted in increased scrutiny of the Internet. Legislators, publishers, 
participants and others have debated what constitutes appropriate use of the Internet and its future 
direction. Some users are concerned about recent trends, and advocate greater controls and 
restrictions. Other users are not in agreement with any measures they feel would restrict their use of 
Internet resources, and their freedom of speech. Areas of particular interest in this ongoing discussion 
are:

Protocol – Accepted forms of behavior on the Internet (as documented in various Internet 
etiquette, or netiquette, guidelines).

Regulations – Legislative and corporate regulations pertaining to such activities as potentially 
libelous postings to newsgroups, copyright violations of Internet resources, and hacking computer 
systems.

Censorship – The recent controversy surrounding the serious issue of “cyberporn” has ignited the 
debate regarding censorship and the right to freedom of speech.



How information travels the Internet

To understand how information travels the Internet, consider the information you must know and the 
steps you take to ensure a letter arrives at its destination. To mail a letter you must:

know the recipient’s address
know the return address
address the envelope
put the letter in the envelope
drop the letter in a mail box for pickup and delivery.

The process of sending information from one computer to another on the Internet is very similar to 
mailing a letter. You decide what you want to send and where it is to be sent, and TCP/IP takes care of 
addressing and delivering your information “package”.

Naming Computers

All computers attached to the Internet (called hosts or sites) are identified by numbers. A site’s 
identifying number is referred to as its IP (Internet Protocol) number. Since sites are also assigned 
names (called addresses) that are easier to remember, you do not have to memorize IP numbers.

Given the number of computers on the Internet, and the need to assign unique names (or addresses) 
to all of them, a multipart naming scheme called the Domain Name System (DNS) was devised. Once 
you learn how DNS works, an address that seems cryptic at first glance actually conveys meaningful 
information about a computer or site.

Understanding the DNS Naming Scheme

An address is a string of letters separated by periods that is read from right to left (with the most 
specific information at the left). The component to the far right is the domain (also called the zone); the 
other components are the subdomains.

Domains fall into two general categories—type of organization and country. A three-letter domain 
signifies a type of organization and a two-letter domain signifies a country. Most North American 
Internet sites use three-letter domains. The following table identifies three-letter domain names.

Domain Type of Organization

com commercial

edu educational institutes

gov government

int international organizations

mil military sites

net networks

org non-profit organizations, professional societies

Thus, a computer named …

brightfuture.com

… is a commercial site, as the “com” domain identifies commercial organizations.

Organizations can have more than one type of domain (universities often have several) and can 
further subdivide addresses to more precisely identify sites.

Your Address



If you have an Internet account with a service provider, you have your own Internet address, which 
looks something like “yourname@server.com” or “yourname@server.net”. Anyone who knows your 
address can send you information, and vice versa.

The “@” symbol separates the user ID to the left of the symbol from the domains and subdomains to 
the right. Your user ID is usually the name you use to log on to your Internet account.

Packaging Information for Delivery

When information is sent from one computer to another on the Internet, it travels as packets of data. 
The larger the information package, the greater the number of packets needed to transport this 
information.

Similar to an addressed envelope, each packet contains information and the addresses of the sending 
and receiving computers. To send a letter to someone using traditional mail services, you must know 
the recipient’s address. The same is true when you send information from your computer to another 
using the Internet. You decide what to send, and where it is going. TCP/IP prepares and delivers the 
packets.

Sending and Receiving Information

As mentioned earlier, the set of signals, or protocols, used to pass packets from site to site is called 
TCP/IP. You can think of TCP/IP as the delivery vehicle carrying your packages. If possible, packets 
are delivered directly, but more often they must pass through many forwarding sites before arriving at 
their destination. This is why the time it takes to deliver a package can vary, depending on the 
conditions on the Internet at any given time. Nevertheless, even “slow” delivery usually takes place in 
seconds.



Tell me about connecting to the Internet

To connect to the Internet, you require the following:

a computer equipped with a modem
a standard telephone line connection
an account with an Internet service provider
dial-up networking protocols, as provided by your service provider, set up on your computer.

A service provider has a direct, permanent connection to the Internet through leased lines, and sells 
access accounts to individuals and organizations. You connect to the Internet by dialing in to the 
service provider’s computer and using its communications protocols, known as SLIP (Serial Line 
Internet Protocol) or PPP (Point-to-Point ). With this type of connection, you:

are assigned your own host name
can download directly to your computer
can use software to navigate the Internet, such as Cyberjack.

For more information on the basic requirements for connecting to the Internet, click here 

Note

If you are connected to a local area network (LAN) that is set up for Internet access, you can 
connect to your service provider directly through your LAN.



What does the Internet Offer?

When you connect to the Internet, you can exchange many types of information. The following are a 
few examples of what you can do:

exchange email with anyone in the world who has an email address
participate in newsgroups by posting and reading messages on a wide range of topics
get the latest stock quotes
review the latest restaurant reviews for a city
read movie reviews
make airline reservations
research an organization to prepare for an interview
play interactive games with other enthusiasts
research topics for a university paper, or for personal interest
participate in live keyboard conversations or “chats”.

Using the Right Tools

A set of common tools used to browse, retrieve and send information—such as World Wide Web, 
newsgroups, IRC, Gopher, Archie, FTP, Finger and Ping—facilitates these activities. However, it is 
important to use the right tool for the task at hand.

To help you select the right tool, you can run the Cyberwizard. For more information, click here 



Windows desktop

Viewing the Install Log

1. Click the Windows Start button, point to Programs, point to Accessories, and click Notepad. The Notepad 
window opens.

2. On the File menu, click Open. The Open dialog appears.

3. Open the folder in which you installed Cyberjack.

4. In the Files of Type drop-down list, select All Files (*.*). 

5. Double click Cybinst.log to view its contents.

The Install Log contains details about your hardware and software, the choices you made during installation, 
and the tasks performed by the Cyberjack Setup program. 



Windows desktop

To view the Readme file

1. Click the Windows Start button, point to Programs, and click Windows Explorer. The Exploring window opens.

2. Open the folder in which you installed Cyberjack.

3. Double click Readme.txt. The Notepad window or another text editor window opens.

Read this file to learn about the changes made since the first editions of the Cyberjack manuals went to press.



Microsoft Office Compatibility

Delrina Cyberjack™ is a Microsoft Office Compatible product, which means that its toolbars and 
menus are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and PowerPoint, then many of the tasks you have 
learned to complete in Office can be completed in a similar manner in Cyberjack. Delrina and Microsoft 
hope these similarities will make it easier for you to use our products together and with other Microsoft 
Office Compatible products.

Look for the Microsoft Office Compatible logo when purchasing software. For more information about 
the Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible 
products in the United States, call Microsoft Customer Service at 1-800-426-9400. Customers outside 
the United States should contact their local Microsoft office.

Delrina Cyberjack and the Office Compatible Features

Toolbars

Cyberjack contains a toolbar which is similar to the ones in Microsoft Office. For example, you can 
copy text just by clicking the    “Copy” button on the standard toolbar, and you can discover each 
button’s function just by pointing to it with the mouse. This will activate a ToolTip that displays the 
name of the button. 

Customize your toolbars to display large, or black and white buttons. Add and remove buttons, or 
display multiple toolbars from the Options command on the Setup menu. Drag the toolbar to position it 
on any side of the Cyberjack window or as a floating toolbar on the window.

Menus

Cyberjack uses menus similar to the ones in Microsoft Office. For example, you can select all items or 
text in the Cyberjack window by clicking the Select All command on the Edit menu.

Wizards

Use the Cyberwizard to connect to Internet sites and browse, chat or search with Cyberjack. Also, use 
a Cyberjack program wizard like the Cyberjack Web Wizard to help connect to a Web site.

Tip of the Day

Learn practical tips for using Cyberjack by reading the Tip of the Day messages displayed at startup. 

Context Sensitive Help

Use the What’s This button to get context sensitive help on options in dialogs.

Using Delrina Cyberjack with Microsoft Office

Use Cyberjack to search for and download graphics files so that you can insert them into Microsoft 
Word documents and PowerPoint presentations. You can also use Cyberjack to download and view 
Microsoft Office files.



Delrina Technical Support Policies

Delrina provides technical support to registered customers only. You can register using the convenient 
online registration provided with Cyberjack. If you have registered your Cyberjack package online prior 
to calling, your name and product information are already on file. Thus, your call is immediately placed 
in priority sequence in the queue.

If you have not yet registered when you call, the Delrina Technical Support representative will help you 
do so. However, registering this way increases the length of your call to Technical Support and may 
cost you additional long distance charges.

The Delrina Technical Support goal is to provide the highest quality support to help you get the most 
out of your Delrina software products. The following policies are intended to provide all customers with 
optimal service.

Delrina provides technical support services only on Delrina software licensed under a valid Delrina 
License Agreement.

Delrina does not provide any technical support services if you have modified or attempted to modify 
the licensed software without written authorization from Delrina. As well, Delrina does not provide any 
technical support if you are attempting to use the licensed software with hardware or software 
(including operating system software) other than those specifically recommended by Delrina.

Delrina does not provide any technical support services on errors or other problems if Delrina 
determines that the cause of the error is the malfunction or failure of any hardware or software not 
furnished by Delrina. Where possible, Delrina tries to direct you to other suitable sources of 
information.

Delrina Technical Support can assist you with specific commands and functions for Delrina products. 
However, neither product training nor application development is provided for you. Contact the Delrina 
Sales Department for information on product training programs and for a list of Delrina Value Added 
Resellers (VARs) in your area who can assist you with application development.

If Delrina Technical Support is unable to get Cyberjack running successfully on your system, Delrina 
can refund your purchase under the terms of the 60-day money back guarantee.

For the latest information on contacting Delrina Technical Support, call the Delrina Fax InfoLine and 
request technical note #9008. Dial the following number:

(416) 443-1614

Note

All customer and technical support services are subject to change without notice.



Preparing to contact Technical Support

Delrina Technical Support is available to help you get the most out of your Delrina products. The 
following information explains how to prepare for your call so that your inquiry can be answered 
promptly.

Gathering information

Take a few minutes before you place your call to gather the information that the Technical Support 
representative may need to diagnose and solve your problem.

If possible, you should be running Cyberjack at the time of your call.

You may be asked for the following information about your workstation: computer brand and model 
name, CPU type and clock speed, modem manufacturer and model name, hardware attached to the 
other COM ports on your computer.

You should also have the following information available.

Serial number

When your call is connected, you will be asked for your serial number identifying you as a registered 
purchaser of the software. If you typed your serial number in during the installation, you can get this 
number while online. 

To get the serial number online, on the Help menu click About Cyberjack. The About Cyberjack dialog 
appears with the serial number. The serial number is also found on the title page of the Getting Started 
guide.

Product date

It is important to give the product date to the Delrina Technical Support representative. To get the 
product date, on the Help menu, click About Cyberjack. The About Cyberjack dialog appears with the 
product date.

Install Log

The Install Log is a file which is created automatically when you run the Setup program. It contains 
details about your hardware and software, the choices you made during installation, and the tasks 
performed by the Cyberjack Setup program.

For information about viewing the Install Log, click click here 

Have the Install Log available during the call for reference.

Documented activities

Make note of any changes you have made to your computer and Windows setup prior to the problem.

If you can reproduce the problem, make note of the steps you take. Also, record any error or other fax 
status messages that appear on the screen when the problem occurs.



Delrina Technical Support Services

Delrina offers support solutions designed to meet your specific needs.

StandardCare Support

Delrina offers 90-day complimentary StandardCare Support to registered users, beginning with your 
first call.

StandardCare Support is available weekdays between 10:00 a.m. and 7:00 p.m. (Eastern Standard 
Time), except statutory holidays. For more information, see your Getting Started guide.

PriorityCare Support

PriorityCare Support is described in detail at the front of your Getting Started guide.

PremiumCare Support

PremiumCare Support is described in detail at the front of your Getting Started guide.

Note

For the latest information on PriorityCare and PremiumCare Support, call the Delrina Fax InfoLine 
at (416) 443-1614 and request technical note #9004.



Contacting Delrina Technical Support electronically

CompuServe

If you are a CompuServe member, use the Delrina forum to get answers to technical questions, as well 
as the latest product information and updates. You can also communicate online with Delrina Technical 
Support representatives.

To use the Delrina forum, connect to CompuServe and type GO SYMANTEC at any prompt to enter 
the Delrina forum.

Delrina tries to respond within two business days to posted questions and requests.

Delrina Bulletin Board Service

Connect to the Delrina Bulletin Board Service (BBS) to get the latest technical notes, helpful tips and 
product information. You can also download product updates and maintenance releases.

The Delrina BBS is available 24 hours a day. To connect, set your modem to: Data bits = 8, No parity, 
Stop bits = 1. You can connect at up to 14.4 baud rate.

To use the Delrina BBS, dial the following number:

(416) 441-2752

This is a download BBS only. You cannot post messages.

Internet

If you have access to the Internet, you can connect to the Delrina Web site and FTP server to find 
news about Delrina products and activities, details about current and upcoming products, a full library 
of technical notes, extensive information about Delrina Technical Support, and useful utilities and 
product updates. 

To access the Delrina Web site, connect to http://www.delrina.com. To access the Delrina FTP server, 
connect to ftp://ftp.delrina.com.

Email

Use email to get answers to your technical questions. Send an email to support@delrina.com and you 
will receive an automated response with detailed information about email addresses for specific 
Delrina products and other methods of contacting Delrina Technical Support.

Delrina Fax InfoLine

Available 24 hours a day, the Delrina Fax InfoLine is a fax on demand service providing an immediate 
fax response to your product questions. Catalogs, organized by product, list Delrina technical notes 
covering all products and releases. Topics range from general product information to performance 
enhancement tips and techniques, specialized procedures and advanced applications. 

Call from any touch tone telephone and follow the voice prompts to make your selection, and the Fax 
InfoLine sends your documents within minutes. Dial the following number: 

(416) 443-1614

TTY Service



Delrina offers 90-day complimentary technical support for customers who are deaf or hearing impaired 
through TTY (teletype) system. 

PriorityCare and PremiumCare Support solutions are also available, and are described in detail at the 
front of your Getting Started guide. 

This service, in English only, is available to any customer worldwide with access to a TTY terminal. 
Dial the following number:

(416) 446-8772.

Delrina TTY technicians are available to return calls weekdays between 9:00 a.m. and 8:00 p.m. 
(Eastern Standard Time), except statutory holidays. 

To receive detailed instructions on how to use the TTY system, call the Delrina Fax InfoLine and 
request technical note #9010. Dial the following number:

(416) 443-1614

The TTY service number is a direct dial number. Do not use operator assistance to place this call.



Requesting materials for special needs

Delrina offers versions of the Cyberjack manuals in ASCII text format, on request, at no extra charge.

To receive a manual, request technical note #9011 from the Delrina Fax InfoLine. This technical note is 
a form letter that must be signed and returned to the fax number indicated. Dial the following number:

(416) 443-1614



Understanding guarantees

Replacement

Your Cyberjack CD ROM or disks have a 90-day limited warranty on materials and workmanship. If 
you find a defect during this period, contact Delrina Customer Service at 1-800-441-7234 to arrange 
for a replacement. 

Delrina does not replace products that are lost, stolen or destroyed. Check your insurance for 
coverage of software products.

Returns

If you are not satisfied with your Cyberjack package, contact the dealer or consultant from whom you 
made the purchase. If you are still not satisfied within 60 days of purchase, contact Delrina Customer 
Service at 1-800-441-7234 to get a Return Materials Authorization (RMA) number and arrange a 
return. 

Delrina accepts complete product packages with a valid RMA number only. 



Reviewing the basic requirements

What You Need to Connect

One of the requirements for connecting to the Internet is obtaining an access account with an Internet 
service provider. A service provider has a direct, permanent connection to the Internet, and sells 
accounts to individuals and organizations.

You can use this account by connecting to your Internet service provider in one of the following ways:

If you have a modem attached to your computer, you can dial up your service provider and log on 
to your account.

If your local area network (LAN) is set up for Internet access, you can connect directly through 
your LAN—you do not need to log on.

Selecting a Service Provider

Before selecting from the vast number of Internet service providers available, you should consider the 
following:

reliability of service
acceptable pricing and billing
qualifications and experience of technical support staff
whether the company is actually providing the service or is a local representative for another 

provider
recommendations of satisfied customers.

Obtaining an Internet Access Account During the Cyberjack Install

If you have not yet obtained an Internet access account, and you are going to be using a dial-up 
connection, you can sign up for a new CompuServe dial-up account during the Cyberjack install.

About Windows 95 Internet Connectivity

Windows 95 includes all of the tools you need (such as TCP/IP and Dial-Up Networking) to set up your 
Internet connection. The procedures in this section of the online help explain how to install, configure 
and use these tools. See “Related Topics” below.

Note

For more information on Internet connectivity in Windows 95, see your Microsoft Windows 95 
documentation.

 Related Topics



Tell me how to set up a new dial-up connection

If you plan to connect to the Internet using Windows 95 Dial-Up Networking, read this section to learn 
the steps you must complete to set up your new connection.

Using a New CompuServe Dial-Up Connection

CompuServe is a North American solution only. If you are going to set up a new dial-up Internet 
access account with CompuServe, do the following.

Step 1: Install TCP/IP, click here 

Step 2: Install Windows 95 Dial-Up Networking, click here 
Step 3: Run the Cyberjack Setup program and install Cyberjack
During the install, run the CompuServe Account wizard to obtain and set up your Internet account. The 
CompuServe wizard provides a quick and easy way to set up a dial-up Internet account, so that you can 
start using Cyberjack right away. If you are installing Cyberjack from the disk set, the installation prompts 
you for the CompuServe diskette. If you are installing from the CD, the installation launches the 
CompuServe Account wizard.

The CompuServe wizard will prompt you for the following information:

first, middle and last name
company name and country and region you will be connecting from
address
phone and fax numbers
dial prefix and suffix for your telephone number (if necessary).

Your local access number is assigned based on the country and region you specify. To ensure you do 
not pay long distance charges for your dial-up connection, verify the country and region setting. If you 
have any problems signing up for or registering your account, call CompuServe at 206-515-2997.

Using a New Dial-Up Connection to Another Provider

If you are going to set up a new dial-up Internet access account with a service provider other than 
CompuServe, do the following.

Step 1: Gather information from your Internet service provider
See “Gathering Information From Your Internet Service Provider“, below.

Step 2: Install TCP/IP, click here 

Step 3: Install Windows 95 Dial-Up Networking, click here 
Step 4: Create your dial-up connection, click here 

Step 5: Configure your dial-up connection, click here 

Step 6: Run the Cyberjack Setup program and install Cyberjack
See the Getting Started guide.

Gathering Information From Your Internet Service Provider

Before continuing, you need some basic information to set up your Internet connection. Check with 
your service provider to ensure you know the following details.

Your logon information

Your service provider will give you the following details:

your user name (or logon ID)
your password



the dial-up telephone number for your service provider.
Your IP address and host name

An Internet Protocol (IP) address is the unique number that identifies you on the Internet.

If your service provider gives you a specific IP address, you have a static IP address. This type of 
address remains constant, and you must specify it when you configure your dial-up connection.

If your service provider does not give you a specific IP address, you have a dynamic IP address. 
With a dynamic address, you do not need to specify the address yourself—it is assigned automatically 
when you log on to your service provider.

You also need to know your host name—the name that identifies your computer to others on the 
Internet.

Your service provider’s setup

Depending on how your service provider is set up, you may need one or more of the following to 
configure your dial-up connection:

the Domain Name Server (DNS) number for your service provider
your service provider’s domain name
the gateway IP address for your service provider
a special logon sequence for your service provider, if required.

You also need to know which dial-up protocol your service provider uses. Most service providers use 
Point-to-Point Protocol (PPP). 

Note

If your service provider uses Serial Line Internet Protocol (SLIP), you will need to configure some 
additional options to set up your connection. For details on configuring a SLIP dial-up connection, see 
your Microsoft Windows 95 online help.

 Related Topics



Tell me how to set up a new LAN connection

If you plan to connect to the Internet through your LAN, read this section to learn the steps you must 
complete to set up your new connection. For instructions on how to complete each step, see the 
accompanying manual reference.

Using a New LAN Connection

To set up a new LAN connection, do the following.

Step 1: Gather information about your LAN connection
See “Gathering Information About Your LAN Connection“, below.

Step 2: Install TCP/IP, click here 

Step 3: Configure your LAN connection, click here 
Step 4: Run the Cyberjack Setup program and install Cyberjack
See the Getting Started guide.

Gathering Information About Your LAN Connection

Not all of the details required for a dial-up connection (such as user name, password and the service 
provider’s telephone number) apply to a LAN connection. In addition, your service provider’s setup will 
affect the way you configure your LAN connection. 

Check with your network administrator for the information you need to set up your LAN connection.

Note

Depending on how your network is set up, not all Internet services may be supported or available. 
Check with your network administrator to see what Internet services are offered on your LAN. If required, 
you can use a dial-up connection in addition to or in place of your LAN connection.

 Related Topics



Windows desktop

To install TCP/IP for a dial-up connection

1. Click the Windows Start button, point to Settings, and click Control Panel. The Control Panel folder opens.

2. Double click Network. The Network dialog appears.

3. Click the Configuration tab.

4. Click Add. The Select Network Component Type dialog appears.

5. Click Adapter, and click Add. The Select Network Adapters dialog appears.

6. Do the following:

In the Manufacturers list, click Microsoft.
In the Network Protocols list, click Dial-Up Adapter.

7. Click OK. The Network dialog reappears.

8. Click Add. The Select Network Component Type dialog appears.

9. Click Protocol, and click Add. The Select Network Protocol dialog appears.

10. Do the following:

In the Manufacturers list, click Microsoft.
In the Network Protocols list, click TCP/IP.

11. Click OK. The Network dialog appears and displays your new dial-up and TCP/IP entries (for example, 
“TCP/IP->Dial-Up Adapter”).

12. To complete the TCP/IP installation, click OK.

13. When prompted to restart your computer, click Yes.

TCP/IP is now installed on your computer. To continue, click here .



Windows desktop

To install TCP/IP for a LAN connection

1. Click the Windows Start button, point to Settings, and click Control Panel. The Control Panel folder opens.

2. Double click Network. The Network dialog appears.

3. Click the Configuration tab.

4. Click Protocol, and click Add. The Select Network Protocol dialog appears.

5. Do the following:

In the Manufacturers list, click Microsoft.
In the Network Protocols list, click TCP/IP.

6. Click OK. The Network dialog appears and displays your new dial-up and TCP/IP entries (for example, 
“TCP/IP->Dial-Up Adapter”).

7. To complete the TCP/IP installation, click OK.

8. When prompted to restart your computer, click Yes.

TCP/IP is now installed on your computer. To continue, click here 



Windows desktop

To install Windows 95 Dial-Up Networking

1. Click the Windows Start button, point to Settings, and click Control Panel. The Control Panel folder opens.

2. Double click Add/Remove Programs. The Add/Remove Programs Properties dialog appears.

3. Click the Windows Setup tab.

4. Enable Communications, and click Details. The Communications dialog appears.

5. Enable Dial-Up Networking, and click OK. The Add/Remove Programs Properties dialog appears.

6. To complete the install, click OK. 

Windows 95 Dial-Up Networking is now installed on your computer. To continue, do one of the following:

If you are going to sign up for a new CompuServe Internet access account, you are now ready to run the 
Cyberjack install. See the Getting Started guide.

If you are setting up a new Internet dial-up connection for another service provider, see “Creating Your Dial-
Up Connection”, next.

Note

When you complete this procedure, Windows adds a Dial-Up Networking folder to your Windows Programs 
folder.

Before installing Dial-Up Networking, make sure you have installed TCP/IP. For details, click here 



Windows desktop

To create the dial-up connection for your service provider

1. Click the Windows Start button, point to Programs, point to Accessories, and click Dial-Up Networking. The 
Dial-Up Networking folder opens.

2. Double click Make New Connection. The Make New Connection wizard appears.

3. In the first field, type the service provider’s name.

4. In the Select a Modem drop-down list, click your modem.

5. Click Next.

6. In the appropriate fields, type the area code and dial-up telephone number for your service provider.

7. In the Country Code drop-down list, click your service provider’s country, and click Next.

8. Click Finish. The new dial-up connection appears in the Dial-Up Networking folder.

Note

Windows adds an icon for the connection to the Dial-Up Networking folder. You can use this icon to start the 
dial-up connection or change the properties of the connection.



Windows desktop

To create a shortcut on your desktop for your dial-up connection

1. Click the Windows Start button, point to Accessories, and click Dial-Up Networking. The Dial-Up Networking 
folder opens.

2. Select the dial-up connection.

3. On the File menu, click Create Shortcut. 

4. When prompted to save the shortcut to the desktop, click Yes.



Windows desktop

To configure the dial-up properties

1. Do one of the following:

If you have created a shortcut on your desktop for your dial-up connection, click the shortcut, and click 
Properties on the File menu.

Click the Windows Start button, point to Programs, point to Accessories, and click Dial-Up Networking. The 
Dial-Up Networking folder appears. Click the entry for your connection, and click Properties on the File menu.

A properties dialog appears for your connection.

2. Click Server Type. The Server Types dialog appears.

3. In the Advanced options section, disable all options. You should only enable these options if instructed to do 
so by your service provider.

4. In the Allowed network protocols section, enable TCP/IP, and disable the other options.

5. Click TCP/IP Settings. The TCP/IP Settings dialog appears.

6. Do one of the following:

If you have a dynamic IP address, click Server Assigned IP Address.
If you have a static IP address, click Specify an IP Address, and type the address in the IP Address field.

7. Click Specify Name Server Addresses, and in the Primary DNS field, type the name server address given to 
you by your service provider.

If you have a dynamic address, but you were not given the name server address, click Server Assigned Name 
Server Addresses.

8. If instructed to do so by your service provider, enable Use IP Header Compression.

9. If instructed to do so by your service provider, enable Use Default Gateway On Remote Network.

10. To save the configuration settings, click OK.

Now that you have configured the dial-up connection, you can use it to dial up your service provider and log on 
to your Internet account.

Notes

For your dial-up connection to work reliably, you need to configure the TCP/IP settings to match the 
requirements of your service provider. For a list of the details you need to know before configuring your connection, 
see “Gathering Information From Your Internet Service Provider”, click here 

If you sign up for a new CompuServe Internet access account during the Cyberjack install, the Cyberjack 
Setup program configures the dial-up connection for you.



Windows desktop

To dial up with a user name and password

1. Do one of the following:

If you have created a shortcut on your desktop for your dial-up connection, double click the shortcut. 
Click the Windows Start button, point to Accessories, and click Dial-Up Networking. In the Dial-Up 

Networking folder, double click your dial-up connection.
The Connect To dialog appears.

2. In the User Name field, type your logon user name. User names are usually case sensitive (for example, 
Pusername is the common format for a PPP account).

3. In the Password field, type your password. Passwords are usually case sensitive.

4. In the Phone Number field, verify the service provider’s phone number.

5. Click Connect. The Connected To dialog appears. Windows dials and connects to your service provider. You 
are now ready to run Cyberjack. You can return to this dialog at any time to disconnect your dial-up 
connection.

Note

In most cases, when you connect to your service provider, you must log on using your user name and 
password. You receive this information from your service provider when you open an account.



Windows desktop

To configure your dial-up logon to use a terminal window

1. Do one of the following:

If you have created a shortcut on your desktop for your dial-up connection, click the shortcut, and click 
Properties on the File menu.

Click the Windows Start button, point to Programs, point to Accessories, and click Dial-Up Networking. The 
Dial-Up Networking folder appears. Click the connection, and click Properties on the File menu.

A properties dialog for the connection appears.
2. Click Configure. A configuration dialog appears for the connection.

3. Click the Options tab.

4. Enable Bring Up Terminal Window After Dialing.

5. Click OK, and then click OK again to apply the changes.

6. Click Connect. A post-terminal logon window appears.

7. Type the logon sequence given to you by your service provider.

8. When the sequence finishes, click Continue. The Connected To dialog appears. Windows dials and connects 
to your service provider. You are now ready to run Cyberjack. You can return to the Connected To dialog at 
any time to disconnect your dial-up connection.

Note

If you know your service provider has a special logon sequence, ask them for a prewritten Windows 95 
logon script for their service. The script may allow you to skip this procedure.



Windows desktop

To change the dial properties for your dial-up connection

1. Do one of the following:

If you have created a shortcut on your desktop for your dial-up connection, double click the shortcut. 
Click the Windows Start button, point to Accessories, and click Dial-Up Networking. In the Dial-Up 

Networking folder, double click your dial-up connection.
The Connect To dialog appears.

2. If you need to change the location setting, select another location in the Dialing From drop-down list.

3. If you need to change the dial properties for the selected location, click Dial Properties. The Dialing Properties 
dialog appears.

4. In the How I dial from this location section, change the settings as required.

If you need to dial a prefix to access an outside line from this location, type the appropriate local and long 
distance prefixes.

To use your telephone credit card to charge the calls you make when dialing up your service provider, 
enable Dial Using Calling Card. The Change Calling Card dialog appears. Specify the details for your calling card, 
and click OK.

To disable call waiting, enable This Location has Call Waiting and select the appropriate code to disable call 
waiting. For most locations in North America, use the *70, setting.

5. Check the Number to be Dialed display at the bottom of the dialog. This is the number sequence Windows 
dials when you connect to your service provider. If this sequence is not correct, or you need to add or modify a 
portion of the sequence, make the required changes.

6. To save the changes and return to the Connect To dialog, click OK.

Tip

If you use Delrina WinComm™ PRO 7.0 or Delrina WinFax™ PRO 7.0, you can configure WinComm or 
WinFax to use the same Windows dialing properties you set for Cyberjack. For details, see your WinFax and 
WinComm documentation.



Windows desktop

To configure TCP/IP for your LAN connection

1. Click the Windows Start button, point to Settings, and click Control Panel. The Control Panel window opens.

2. Double click Network. The Network dialog appears.

3. In the list of network components, click the TCP/IP entry for your network card (for example, “TCP/IP->Novel 
NE2000).

4. Click Properties. The properties dialog for your LAN TCP/IP connection appears.

5. Click the IP Address tab. 

6. Depending on the type of IP address you have, do one of the following:

 If you have a dynamic IP address, enable Obtain an IP address automatically.
 If you have a static IP address, click Specify an IP address and type your IP address in the fields provided. If 
your service provider did not specify a subnet mask number, use 255.255.255.0 as the default setting. Other common 
defaults are 255.255.0.0 or 255.0.0.0 for the subnet mask setting.

7. If you are required to use a gateway when connecting through your LAN, click the Gateway tab.

8. If your gateway number is not the first entry in the Installed gateways list, type the number in the New gateway 
field, and click Add.

9. Click the DNS Configuration tab.

10. Do the following:

 In the Host field, type your host name.
 In the Domain field, type the domain name for your service provider.
 In the DNS Server Search Order section, type the DNS number for your service provider.
11. Click OK.

12. When prompted to restart your computer, click OK.

Note

You can configure TCP/IP to work with devices such as SMC Ethercards, Novell NE2000 network cards, or 
other types of Ethernet cards. Contact your network administrator for details on the best settings to use.

See “Installing TCP/IP”, click here 
You must have installed TCP/IP on your computer before you can configure it for your LAN connection.



Windows desktop

To connect through your LAN

Once your LAN connection is set up, you do not need to log on to your service provider before using 
Cyberjack.

When you want to connect to the Internet using Cyberjack, start the appropriate Cyberjack program and 
connect to a site. Your network handles the connection in the background automatically.



Tell me how to set up existing CompuServe accounts

Before you can use Cyberjack with your existing CompuServe account, you must do the following: 

copy the SCRIPTER.EXE scripting tool and CIS.SCP script file to your computer 
create and configure a CompuServe dial-up connection
associate the CompuServe script file with your CompuServe dial-up connection 
dial up CompuServe. 

Copying the Scripting Tool and CompuServe Script File 

The SCRIPTER.EXE scripting tool creates your dial-up scripting by associating the CIS.SCP script file 
with your CompuServe dial-up connection. The script file provides your user name, password and 
other information to CompuServe so that you can log on to your account and access the Internet. If 
you do not already have the scripting tool and script file, copy them to your computer by doing one of 
the following: 

installing SLIP and Scripting for Dial-Up Networking from the Windows 95 CD
installing SLIP and Scripting for Dial-Up Networking from the Microsoft Plus Pack 
downloading SLIP and Scripting for Dial-Up Networking from the Microsoft Web site. 

Note

SLIP and Scripting for Dial-Up Networking is not included with the 3.5 inch disk version of 
Windows 95.



Windows desktop

To install SLIP and Scripting for Dial-Up Networking from the Windows 95 CD

1. Start Windows.

2. Insert the Windows 95 CD into the CD ROM drive of your computer.

3. Click the Windows Start button, point to Settings, and click Control Panel. The Control Panel window opens.

4. Double click Add/Remove Programs. The Add/Remove Programs Properties dialog appears.

5. Click the Windows Setup tab.

6. Click Have Disk. The Install From Disk dialog appears.

7. Click Browse. The Open dialog appears.

8. Select your CD drive letter and open the ADMIN\APPTOOLS\DSCRIPT\ folder.

9. Select the RNAPLUS.INF file and click OK. 

The ADMIN\APPTOOLS\DSCRIPT\ folder should appear in the Install From Disk dialog.

10. Click OK. The Have Disk dialog appears. 

The SLIP and Scripting for Dial-Up Networking should appear in the Components drop-down list.

11. Click Install to copy the scripting tool and script file to your computer.



Windows desktop

To install SLIP and Scripting for Dial-Up Networking from the Microsoft Plus Pack

The SCRIPTER.EXE scripting tool and CIS.SCP script file are installed on your computer when you install the 
Microsoft Plus Pack. These files can be found in the folder C:\PROGRAM FILES\ACCESSORIES. For installation 
procedures, see the Microsoft Plus Pack documentation. 



Windows desktop

To download SLIP and Scripting for Dial-Up Networking from the Microsoft Web site

If the software you use to connect to CompuServe gives you Web access (such as WinCIM 2.01 version), you can 
download the SLIP and Scripting Dial-Up Networking from the Microsoft Web site.

1. Connect to the following Web site:

http://www.windows95.com/connect/dscript.html

2. On the Web page, see “Step 3: Verify that the Dial-up Scripting Tool is Installed”.

3. Select click here and download the DSCRPT.EXE file. 

4. Copy DSCRPT.EXE to the C:\PROGRAM FILES\ACCESSORIES folder on your computer. 

5. Double click DSCRPT.EXE to extract the SCRIPTER.EXE scripting tool and CIS.SCP script file.



Windows desktop

To configure the dial-up properties for CompuServe

1. Click the Windows Start button, point to Programs, point to Accessories, and click Dial-Up Networking. The 
Dial-Up Networking folder appears. 

2. Select your CompuServe dial-up connection, and click Properties on the File menu. The Properties dialog 
appears. 

3. Click Server Type. The Server Types dialog appears. 

4. In the Advanced Options section, disable all options. You should only enable these options if instructed to do 
so by your service provider.

5. In the Allowed Network Protocols section, enable TCP/IP, and disable the other options. 

6. Click TCP/IP Settings. The TCP/IP Settings dialog appears. 

7. Click Server Assigned IP address. 

8. Click Specify name server addresses and do the following:

 In the Primary DNS field, type: 
149.174.211.5

 In the Secondary DNS field, type: 
149.174.213.5 

9. If instructed to do so by CompuServe, enable Use IP header compression. 

10. If instructed to do so by CompuServe, enable Use default gateway on remote network. 

11. To save the configuration settings, click OK. 

Now that you have configured the dial-up connection, you can use it to dial up CompuServe and log on to your 
Internet account. 



Windows desktop

To associate the script file with your CompuServe dial-up connection 

To associate the script file with your CompuServe dial-up connection 

1. Click the Windows Start button, point to Programs, and click Windows Explorer. The Exploring window opens. 

2. Open the C:\PROGRAM FILES\ACCESSORIES folder. 

3. Double click SCRIPTER.EXE. The Dial-Up Scripting Tool dialog appears. 

4. In the Connections section, select CompuServe. 

5. In the Script section, click Browse. The Open dialog appears.

6. Open the C:\PROGRAM FILES\ACCESSORIES folder and select the CIS.SCP script file. 

7. Click Apply to save the changes.



Windows desktop

To dial up your service provider

1. Do one of the following:

If you have created a shortcut on your desktop for your dial-up connection, double click the shortcut.
Click the Windows Start button, point to Accessories, and click Dial-Up Networking. In the Dial-Up 

Networking folder, double click your dial-up connection. The Connect To dialog appears.
2. In the User name field, type your logon user name. User names are usually case sensitive.

3. In the Password field, type your password. Passwords are usually case sensitive.

4. In the Phone number field, verify the service provider’s phone number.

5. Click Connect. The Connected To dialog appears. Windows dials and connects to your service provider. You 
are now ready to run Cyberjack. You can return to this dialog at any time to disconnect your dial-up 
connection.

Note

When you want to connect to the Internet using Cyberjack, you first need to dial up and log on to your 
service provider using your user name and password. You receive this information from your service provider when 
you open an account.



Tell me about ways to access the Internet

Starting From the Cyberwizard

If you are new to the Internet, or you simply want some assistance using the various Cyberjack 
programs, try using the Cyberwizard—the primary Cyberjack wizard. It can direct you to the 
appropriate Cyberjack program based on the task you want to accomplish.

The Cyberwizard presents Internet scenarios, such as “Surf the Net” and “Search for Info”. All you 
need to know is what activity you want to pursue. Clicking a scenario starts another wizard for the 
appropriate Cyberjack program.

The Cyberjack program wizard prompts you for information as it takes you through the required steps. 
When you finish the wizard, you have accomplished your task.

Starting From the Guidebook

The Cyberjack Guidebook is a personal organizer for storing connections to your favorite Internet 
sites. Entries in the Guidebook are saved as CyberLinks. A CyberLink contains a site address, and 
information about the Cyberjack program used to connect to that site. Double clicking a CyberLink 
connects you to that site.

As you navigate the Internet, you can save any site to your Guidebook as a CyberLink by clicking 
Save on the toolbar.

You can also use the Guidebook to start Cyberjack programs.

A collection of hundreds of CyberLinks has been prepared to help you start exploring the Internet. The 
first time you open the Guidebook, you have the option of copying the selection to your Guidebook.

Connecting Using a Cyberlink

You can begin exploring the Internet immediately using the collection of CyberLinks copied to your 
Guidebook during the Cyberjack installation. You can also create your own CyberLinks to sites you 
discover as you navigate the Internet.



Windows desktop

To use the Cyberwizard

1. Click the Windows Start button, point to Programs, point to Cyberjack 7.0, and click Cyberwizard. The 
Cyberwizard starts.

2. Click an activity. The wizard for the appropriate program starts.

3. Follow the instructions on the screen.



Windows desktop

To start the Guidebook

Click the Windows Start button, point to Programs, point to Cyberjack 7.0, and click Guidebook.



Cyberjack Guidebook

To connect to a site using a CyberLink

1. In the Guidebook folder list, click the folder you want to view. The CyberLinks appear in the item list.

2. Double click the appropriate CyberLink. The associated Cyberjack program starts and connects to the site.



Windows desktop

To start Cyberjack programs

 You can start any of the Cyberjack programs from the Windows Start button. For example, to start Cyberjack 
Web, click the Windows Start button, point to Programs, point to Cyberjack 7.0, and click Cyberjack Web.

Note

 To exit any of Cyberjack programs, click Exit on the leftmost menu item.



Cyberjack Guidebook

To add a new folder to the Guidebook

1. In the folder area, click a folder.

2. On the Guidebook menu, point to New, and click Folder. The new folder appears in the folder area.

3. Type the name of the new folder.

 Related Topics



Cyberjack FTP

To create a folder at your service provider using FTP

1. Connect to your service provider’s FTP site. 

2. On the Item menu, click Create New Folder. The Directory Name dialog appears.

3. Type the name of the new folder.

Notes

Before you can create folders at an FTP site, the site’s administrator grant you write access.
For more information on using FTP, click here 

 Related Topics



All Cyberjack programs

To select all items

1. In the folder area, double click the appropriate folder.

2. On the Edit menu, click Select All.

 Related Topics



All Cyberjack programs

To invert selected items

1. In the folder area, double click the appropriate folder.

2. Select several items by doing one of the following:

Click the first item, press and hold down SHIFT, and click the last item of the group.
Press and hold down CTRL and click each item.

3. On the Edit menu, click Invert Selection. All items in the list other than those you had highlighted are now 
selected.

 Related Topics



All Cyberjack programs

To find text

1. On the Edit menu, click Find. The Find dialog appears.

2. In the Find What field, type your search word.

3. Click Find Next. If the word is in the file it is highlighted.

Tip

On the Edit menu, click Find Next to continue searching for your word.



All Cyberjack programs

To copy and paste text

1. In the text file, select the text you want to copy.

2. On the Edit menu, click Copy. 

3. Start the Windows program you want to copy the text to.

4. Click where you want to insert the text and paste it.

Note

You can copy text from a file to the Windows Clipboard, or copy a file to your default download folder. You 
cannot copy folders.

 Related Topics



All Cyberjack programs

To copy a file 

1. Click the file you want to copy.

2. On the Edit menu, click Copy. The file is copied to your default download folder.

 Related Topics



Cyberjack Web, Cyberjack Archie and Cyberjack FTP

To download a file

Double click the file (single click in Cyberjack Web). The file is downloaded to your default download folder.

Tips

To quickly download a file, drag it to a folder on your computer.
If you are using Cyberjack Gopher, you can double click a file to view its contents before downloading it.

 Related Topics



Cyberjack FTP, Cyberjack Archie and Cyberjack Gopher

To download a file in Cyberjack FTP, Cyberjack Archie or Cyberjack Gopher

1. Select the file to download.

2. On the Item menu, click Retrieve File. The file is downloaded to your default download folder.

 Related Topics



Cyberjack Web, Cyberjack News, Cyberjack IRC, Cyberjack FTP, Cyberjack Archie and Cyberjack Gopher

To confirm when downloading a file

1. On the Setup menu of your Cyberjack program, click Options. 

2. Click the Transfers tab.

3. Enable Confirm Before Overwriting Existing Files.

4. Using a Cyberjack program, double click a file (single click in Cyberjack Web). A Save dialog appears.

5. In the Save In field, click the destination Windows folder.

6. In the File Name field, type the name, and click Save. The file downloads.

Note

The Confirm When Downloading option must be set for each Cyberjack program.

 Related Topics



All Cyberjack programs

To open the download folder

1. On the Tools menu, click Open Download Folder. The Download folder opens. 

2. In the download folder, copy or drag the files to other folders.

Note

Once you have downloaded files to the download folder, you can open the folder and retrieve the files.

 Related Topics



Tell me about downloading files 

Once you find a file on the Internet you can download it to your computer. If you have the appropriate 
program for the file type you have downloaded, you can click it and Windows starts the program. For 
example, if you download a text file and click it, Windows Notepad starts.

If you download an image file to your computer, Image Manager displays the image. For more details, 
click here 

Working With Large Files

If you select a large file and it takes a long time to download, you can do one of the following:

stop the file transfer by clicking the Stop button on the toolbar
start a new session and continue to browse and search sites.

Tips

Before downloading a file, check its size by looking at its item properties.
With Cyberjack Archie you may be able to locate public domain software to run some of the file 

types you find on the Internet. For details on using Cyberjack Archie, click here 

 Related Topics



Cyberjack Web and Cyberjack Archie

To change your printer setup

1. On the Page menu, click Print Setup. The Print Setup dialog appears.

2. From the Printer section, do any of the following:

In the Name drop-down list, select a printer.
Click Properties to change the print properties for your printer.

3. In the Paper section, do any of the following:

In the Size drop-down list, select a paper size.
In the Source drop-down list, select a paper tray.

4. In the Orientation section, click one of the following:

Portrait to print the Web page in portrait format. 
Landscape to print the Web page in landscape format.
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Cyberjack Web and Cyberjack Archie

To print a Web page or a file

1. On the leftmost menu, click Print. The Print dialog appears.

2. In the Printer section, do any of the following:

In the Name drop-down list, select a printer.
Click Properties to change the print properties for your printer.

3. In the Paper Range section, click one of the following:

All to print the full contents of the Web page or file.
Pages to print a range. Specify the range in the from and to fields.
Selection to print the previously selected text on a Web page or file.

4. In the Copies section, do any of the following:

Change the setting in the Number of Copies field to specify the number of copies to print.
Enable Collate to automatically sort and collate the print job.

Note

You can only print a Web page after transferring it to your system.

 Related Topics



Cyberjack Archie

To preview pages in Cyberjack Archie

1. On the Query Menu, click Print Preview. The Print Preview dialog appears.

2. To preview the file, click any of the following:

Next Page to view the following page
Previous Page to view the preceding page
Two Page to view two pages
Zoom In to view a page in more detail
Zoom Out to view a page with less detail.

3. Click Print or Close when you have finished previewing the file.

 Related Topics



Cyberjack Web and Cyberjack Gopher

To display previous items and next items

On the View menu, click Previous.
On the View menu, click Next.

 Related Topics



All Cyberjack programs

To display previously saved sites from the leftmost menu item

1. Click the leftmost menu item. Previously saved sites appear as URLs near the bottom of the menu.

2. Select the URL to connect to the site.

 Related Topics



All Cyberjack programs

To display site properties

1. Click the folder or file you want to display site properties for.

2. On the leftmost menu, click Properties. The Properties dialog appears with information about the item’s site.

 Related Topics



Cyberjack News, Cyberjack Gopher, Cyberjack Archie and Cyberjack FTP

To display item properties

1. Click the folder, file, article or other item you want to display properties for. 

2. On the Item menu, click Properties. The Properties dialog appears with information about the item.

Tip

If you are using Cyberjack Gopher, click a Gopher+ file to learn additional information on folders and files. 
For more details click here 

 Related Topics
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To save a CyberLink to one of your folders

1. Connect to an Internet site using one of the Cyberjack programs.

2. On the Page menu (or leftmost menu item), click Save. The Save As dialog appears.

3. In the Save field, select the folder to which you want to save the CyberLink and click Save.

 Related Topics



All Cyberjack programs

To copy and paste a CyberLink

1. Click the file you want to copy.

2. On the Edit menu, click Copy. 

3. Do one of the following:

Open a folder to paste the CyberLink
Start the Windows program you want to copy the CyberLink to.

4. Click where you want to insert the CyberLink and paste it.

 Related Topics



Tell me about sending email

If you have an existing email program, you can send messages and CyberLinks from Cyberjack to 
other users on the Internet. You can also start your email program from Cyberjack to check for any 
incoming messages.

You must have Microsoft Exchange or another MAPI-compliant email program installed on your 
computer to use email with Cyberjack.

Sending Email Messages

With Cyberjack, you can use your email program to send messages to other users on the Internet.

Sending CyberLinks by Email

With any Cyberjack program, you can email CyberLinks to other users in the following ways:

when you are visiting a site, you can send a CyberLink of that site to other users
when you are in the Guidebook, you can send all of its CyberLinks to other users.

Notes

If you are using Microsoft Exchange, you must select the Exchange profile that includes the 
Internet service provider each time you start Exchange. In the Exchange Choose Profile dialog, select the 
profile you want to use. For more information, see your Microsoft Windows 95 documentation.

If you are using Microsoft Exchange, you can write email messages offline, and send them when 
you connect to the Internet. When connected, in the Tools menu, click Deliver Now to send your email.

 Related Topics



Cyberjack Guidebook

To send a new email message

1. Click the Windows Start button, point to Programs, point to Cyberjack 7.0, and click Guidebook. The 
Guidebook window opens.

2. On the Start menu, click Electronic Mail. Your email program appears.

3. Specify the email address of the recipient.

4. Type your message in the message area.

5. Send your message.

 Related Topics



Cyberjack Guidebook

THIS TOPIC HAS BEEN TEMPORARILY REMOVED

 To check for incoming email messages

1. Click the Windows Start button, point to Programs, point to Cyberjack 7.0, and click Guidebook. The 
Guidebook window opens.

2. On the Start menu, click Electronic Mail. Your email program appears.

3. Retrieve your received messages. For example, in Microsoft Exchange, on the Tools menu, click Deliver Now. 
Any incoming email is retrieved from your service provider.

 Related Topics
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To send a CyberLink by email when you are visiting a site

1. On the leftmost menu item, click Send.

2. In the To field, type the full email address of the recipient. 

3. On the File menu, click Send.

 Related Topics



Cyberjack Guidebook

To send the Guidebook’s CyberLinks by email 

1. On the Guidebook menu, click Send. The Guidebook appears in the message area of your email program.

2. In the To field, type the full email address of the recipient.

3. On the File menu, click Send.

 Related Topics



All Cyberjack programs

To show the toolbars and status bar

On the View menu, enable Toolbars.
On the View bar, enable Status Bar.

 Related Topics



All Cyberjack programs

To hide the toolbars and status bar

On the View menu, disable Toolbars.
On the View bar, disable Status Bar.

 Related Topics
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To customize Cyberjack toolbars

1. On the Setup menu, click Options. The Options dialog appears.

2. Click the Toolbars tab. 

3. In the Toolbars list, click the toolbar you want to edit.

4. Enable one or more of the following:

Color Buttons to display buttons in color instead of black and white
Large Buttons to increase the button sizes
Delrina Classic Buttons to display the Delrina classic button style for the toolbars. Enable Captions to display 

captions for the Delrina classic button.
Show ToolTips to display a text message explaining how to use a button. A message appears when you hold 

the mouse over a button.

Note

You cannot enable both Large Buttons and Delrina Classic Buttons at the same time.
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To add a new button

1. Click New. The Toolbar Properties dialog appears.

2. In the Available Buttons section, click the button you want to add.

3. Click Add. The button is added to the toolbar section.

4. To change the properties for a button, select it in the toolbar section. In the Button Assignments section, 
modify the details as required.

5. Click OK. The Toolbar Properties dialog reappears.
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All Cyberjack programs

To edit an existing toolbar

1. Click Edit. The Toolbar Properties dialog appears.

2. In the Available Buttons section, click the button you want to add.

3. Click Add. The button is added to the toolbar section.

4. To change the properties for a button, select it in the toolbar section. In the Button Assignment section, change 
the details as appropriate.

 Related Topics



All Cyberjack programs

To remove a button from the toolbar

1. In the Toolbars list, click the toolbar you want to remove.

2. Click Edit. The Toolbar Properties dialog appears.

3. In the Toolbar section, click the button you want to remove from the toolbar.

4. Click Remove. Cyberjack removes the button from the selected toolbar.

Note

If required, you can revert to the default toolbar by clicking Reset.

 Related Topics



Tell me about Ping

Ping is a diagnostic tool that shows you the connection status of an Internet site. When you experience 
trouble connecting to an Internet site, Cyberjack Ping provides details on the reliability and speed of 
the connection to the site. 

Cyberjack Ping calls an Internet site to see if it is available. If the site responds to Cyberjack Ping, you 
know it is there and is operating. The call is made by sending packets of data to the site and waiting 
for a reply (echo). Relatively long response times and lost data packets indicate a poor Internet 
connection. If Cyberjack Ping is unable to connect to the site, you either have the incorrect site 
address or the site is not currently active. Make sure you have the correct address for the site, and try 
connecting later.

You can expect one of three basic responses from Cyberjack Ping:

it cannot connect to the Internet site
it can connect to the Internet site
it cannot establish a reliable connection to the site.

Note

For a listing of system errors and their meanings, click here 
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To start Cyberjack Ping

1. On the Tools menu, click Ping site. Cyberjack Ping appears.

2. In the Site field, type the address of the Internet site. Cyberjack Ping tests the connection.

Note

If you see Cyberjack Ping when trying to connect to a site, click Ping to test the connection.

 Related Topics



Tell me about the Cyberjack Ping messages

Cyberjack Ping Successful Connection Message

If the Internet site you are trying to connect to is active, busy or out of service, the Pinging dialog 
shows the following message:

Current Status: Host Found 

Average response time: 242 ms (or something similar)

Last response time: 220 ms (or something similar)

To close the dialog, do one of the following:

click Cancel to close the dialog. 
click Retry if you started Cyberjack Ping from the Connect Error dialog. 

Cyberjack Ping Host Lookup Failure Message

If you type the wrong address or the Internet site no longer exists, the Pinging dialog shows the 
following message:

Current Status: Host Lookup Failed 

Average response time: None

Last response time: None

To close the dialog, click Cancel.

Cyberjack Ping Timeout Message 

If the Internet site you are trying to contact exists, but it is busy or experiencing problems, the Pinging 
dialog shows the following message:

Current Status: Host Lookup Failed 

Average response time: 521 ms (or something similar)

Last response time: Timeout on Ping

To close the dialog, do one of the following:

click Cancel to close the dialog.
click Retry if you started Cyberjack Ping from the Connect Socket Error dialog.

 Related Topics



Tell me about files types

There are many file formats you will find on the Internet. They can be categorized into five basic types:

text/document files
program files
sound files
image files
compressed files.

The following is a short list of some of the more common file formats you can find on the Internet. Each 
file type is explained in a short description that follows each file extension.

Most of these files require third-party programs to run. Some file types (like Macintosh files or UNIX 
programs) may not run on your computer. 

With Archie, you can locate public domain software to run some of the file types you find on the 
Internet.

Text File Formats

.doc Microsoft Word document file. Can also be an 
ASCII text file.

.faq Frequently Asked Questions, usually in an ASCII 
text file format.

.hlp Windows Help file.

.htm Hypertext Markup File. This file type can be read 
directly by Cyberjack Web.

.html Hypertext Markup File. This file type can be read 
directly by Cyberjack Web.

.ppt Microsoft PowerPoint file.

.rtf Rich Text Format file.

.wpd WordPerfect document file.

.wri Microsoft Write text file.

.xls Microsoft Excel spreadsheet file.

Program File Formats

.bat Batch file, can be MS-DOS or UNIX in origin.

.com Command file, usually an MS-DOS file.

.exe Executable DOS/Windows program. Can also be 
a compressed, self-extracting MS-DOS 
executable. 

Sound File Formats

.aif Macintosh sound file.

.aiff Macintosh sound file (same as .aif).

.au Sun Microsystems/NeXT sound file format.

.mod Amiga sound file.



.ram RealAudio sound file.

.snd Sun Microsystems/NeXT sound file format (same 
as .au).

.tsp TrueSpeech sound file.

.voc SoundBlaster sound file.

.wav Microsoft sound file.

Image File Formats 

.avi Microsoft Windows movie file.

.bmp Windows Bitmap image file.

.cmp LEAD image file.

.eps Encapsulated PostScript file.

.dpx Digital Moving Picture Exchange movie file.

.gif Graphic Interchange Format image file.

.jff JPEG File Interchange Format image file.

.jpeg JPEG image file.

.jpg JPEG image file (same as .jpeg).

.mpeg Motion Pictures Engineering Group movie file.

.mpg Motion Pictures Engineering Group movie file 
(same as .mpeg).

.pcx PC Paintbrush image file.

.pdf Adobe Acrobat image file.

.pov Persistence of Vision raytracing file.

.ps PostScript file.

.qt Quick Time movie file. 

.ras Sun Microsystems raster image file.

.tif Tagged Image File image file

.tga Truevision (Targa) file.

.wpg WordPerfect Graphics Metafile.

.xbm UNIX X-windows Bitmap file.

Compressed File Formats

.arc ARC compressed file.

.arj ARJ compressed file.

.exe Self-extracting MS-DOS executable. Can also be 
a stand-alone executable DOS/Windows 
program. 

.gz GZIP compressed file.



.hqx Macintosh BinHex file.

.lha LHARC compression file.

.lzh LHARC compression file (same as .lha).

.sea Macintosh self-extracting archive file.

.sit STUFFIT for Macintosh compressed file.

.tar Unix TAR archive file.

.tar.Z Unix TAR archive file that has been Unix 
COMPRESSed.

.tar.gz Unix TAR archive file that has been compressed 
using GZIP.

.z GZIP compressed file (same as .gz).

.Z Unix COMPRESS file. This differs from a .z file.

.zip PKZIP compressed file.

.zoo ZOO compressed file.

Getting the latest troubleshooting information

Troubleshooting information is updated on a regular basis through the Delrina technical note library. If 
you cannot find what you need in the troubleshooting section of the online help, check the Delrina 
technical note library in one of the following ways:

connect to the Delrina Bulletin Board Service (BBS)
connect to the Delrina World Wide Web site (WWW)
call the Delrina Fax InfoLine.

For more information on how to access these services, click here 



Checking the basics first

The following information outlines a basic troubleshooting routine you can try first before looking to 
other solutions. Sometimes referred to as the “Package” by Delrina Technical Support representatives, 
it is designed to address a wide variety of situations that may contribute to system instability, and 
hence to Cyberjack problems.

Situation:

Any of the following situations occur when sending or receiving data:

intermittent failures
program failures
system lockups.

Solution:

Try the following problem-solving package:

 checking for phone line problems
 checking modem connections (if you use a modem to connect to the Internet)
 deleting Windows temporary files
 checking your hard disk and repairing file system errors
 disabling Windows 3.1 version TSRs and other memory-resident programs.
You can try each of these steps individually to solve your problem, or perform the entire procedure to 
troubleshoot your system.



Checking for phone line problems

If you are encountering a transmission error due to a phone line problem, it is probably related to a bad 
line (noisy, busy, and so on). Since the condition causing the problem may be temporary, it is best to 
allow some time to elapse, then try connecting to your Internet service provider again. If the line 
problem persists, contact your local phone company.



Checking modem connections

Check the connection between the modem and the phone line. Make sure that the phone line is 
properly attached to the phone jack on the wall. Also, check that the phone line is connected to the line 
jack on the modem and not to the extension jack for a telephone. The phone line should come directly 
from the wall jack and into the modem.

If you have an external modem, turn it off and on again to reset it. If you have an internal modem, you 
can reset it by exiting Windows and turning off the computer, then waiting ten seconds before turning 
the computer back on.



Deleting Windows temporary files

Windows 95 and many Windows programs, including Cyberjack, create temporary files. Sometimes 
these temporary files can become damaged or they are not deleted when they should be. This often 
occurs if you reboot or turn off your computer without properly exiting Windows. 

To ensure Windows temporary files do not become a problem, you should routinely delete these files 
as part of your regular system maintenance for Windows 95.

1. Close any programs you are running.

2. Click the Windows Start button, then click Shut Down. The Shut Down Windows dialog appears. 

3. Click Restart the Computer in MS-DOS Mode. 

4. Click Yes. Windows restarts the computer in DOS mode.

5. At the DOS prompt, type ...

SET

... and press ENTER. The environment variables for your computer system are displayed.

6. Change to the subdirectory identified in the TEMP= line of the environment variable display.

7. To delete all temporary files, type ...

DEL ~*.TMP

... and press ENTER.

Tip

Adding the tilde (~) character to this command ensures that you delete Windows temporary files 
only.



Checking your hard disk and repairing disk problems

Run the ScanDisk utility to locate and repair file system errors on your hard disk. Before running this 
utility, check your Windows 95 documentation. This procedure should be part of your regular system 
maintenance for Windows 95.

If you use a disk compression program, check the program’s manual to see if using ScanDisk is 
recommended.

1. On the Windows desktop, double click My Computer.

2. Select the disk drive you want to scan. Typically, this is your C: drive.

3. On the File menu, click Properties. The Properties dialog appears.

4. Click the Tools tab.

5. In the Error-checking status section, click Check Now. The ScanDisk dialog appears.

6. Select the disk drive you want to check.

7. In the Type of test section, click Thorough and enable Automatically fix errors.

8. Click Start. ScanDisk checks the disk and repairs any errors.



Disabling 16-bit TSRs

If you run Windows 3.1 (16-bit) versions of screen savers, anti-virus software or other memory-resident 
programs, you should disable these programs. These 16-bit programs can interfere with your Windows 
95 setup, or in the case of anti-virus programs, they can damage the Windows 95 Registry.

You can disable 16-bit memory-resident programs by editing your Windows 3.1 configuration files—
AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI. In most cases, the entries in these files are not needed 
for Windows 95.

If you are connected to a network, check with your network administrator if you are unsure about which 
TSRs (Terminate and Stay Resident) to disable.

1. Make a backup copy of your AUTOEXEC.BAT, CONFIG.SYS and WIN.INI files.

2. Click the Windows Start button, then click Run. The Run dialog appears.

3. In the Open field, type ...

SYSEDIT

... and click OK. The System Configuration Editor opens and displays your system configuration 
files.

4. Click the title bar of the AUTOEXEC.BAT window.

5. In your AUTOEXEC.BAT, disable all 16-bit drivers, programs and TSRs not necessary for the 
computer to run and log on to your network (if applicable). Type REM at the beginning of the line for 
each program you want to disable. 

This changes the line to a non-executable remark. If required, after you finish testing, you can 
delete REM to make the line executable again.

6. Click the title bar of the CONFIG.SYS window. Repeat step #5 to disable 16-bit programs and 
TSRs in this file.

7. Click the title bar of the WIN.INI window. In the [Windows] section of the WIN.INI file, disable the 
LOAD= line by typing a semicolon (;) at the beginning.

8. On the File menu of the System Configuration Editor, click Save and then Exit.

9. Exit and restart Windows and repeat the steps that produce your problems. 

If the problems are corrected, you can restore one of the lines from your AUTOEXEC.BAT file on 
your computer hard disk (delete the REM at the beginning of the line). Restart your computer, run 
Windows and repeat the steps that produce the problem. Repeat this sequence, restoring one line 
at a time from AUTOEXEC.BAT, CONFIG.SYS and WIN.INI until you determine which line is the 
source of the problems.



Creating a permanent swap file to improve system performance

Create a permanent swap file to improve system performance. You need 50 MB of free space to do 
this. You also need to defragment your hard drive. Do the following:

1. Double click My Computer. The My Computer window opens.

2. Right click the local hard drive icon, usually C:. Click Properties. The Properties dialog for your 
local hard drive appears. 

3. Click the Tools tab.

4. Click Defragment Now. The Disk Defragmenter dialog appears. Click Start.

5. After the defragmentation process is complete, from the Windows Start button, point to Settings 
and click Control Panel. The Control Panel window appears.

6. Double click System. The System Properties dialog appears.

7. Click the Performance tab.

8. Click Virtual Memory. The Virtual Memory dialog appears.

9. Enable Let Me Specify My Own Virtual Memory Settings.

10. In the Minimum field, type 50. In the Maximum field, type 50. Click OK. The Confirm Virtual 
Memory Settings dialog appears.

11. Click Yes. Click Close. The System Settings Change dialog appears.

12. Click Yes to reboot your computer. 

If you do not note any improvement in system performance after rebooting, you can return Windows to 
its default swap file settings by following steps 1 - 4, then enable Let Windows Manage My Virtual 
Memory Settings. Proceed as prompted.



Checking the Windows 95 version

Delrina's Windows 95 software was designed to operate with the release version of Windows 95, and 
not any previous beta version of the program. You can determine if you have the final release version 
of Windows 95 by doing the following: 

1. Right click My Computer.

2. Select Properties.

3. Click the General tab. The System section should read as follows:

Microsoft Windows 95

4.00.950

Any number prior to this indicates that you are running a beta copy of Windows 95. If you are running 
a beta copy of Windows 95, upgrade to the final release version of Windows 95.



Battery operated modem

Situation: Cyberjack is not communicating with your battery operated or pocket 
modem. You have successfully used this setup in the past, and you 
have not made any changes to the setup or configuration of either 
Cyberjack or your modem since then.

Solution: Your modem may be deactivated or in “deep sleep” mode. This is 
common among battery operated pocket modems. The modem 
automatically shuts itself down after a certain period of inactivity.

Turn off the modem for a few seconds, then turn it back on to bring it 
out of deep sleep mode.

Communication problems with your PCMCIA modem

Situation: Cyberjack is unable to communicate with your PCMCIA modem.

Solution: All PCMCIA modems rely on software drivers to operate. Software 
drivers control how the notebook computer connects to and operates 
with the PCMCIA modem. Most of the problems that arise with 
PCMCIA drivers and Cyberjack have to do with either the driver 
software itself, or how it is set up and working with the notebook.

Make sure that you have the latest PCMCIA driver software from your 
notebook manufacturer. Typically, the version number of these drivers 
can be found on the PCMCIA diskettes that come with the modem or 
your notebook computer. Call your notebook manufacturer and ask for 
the date and version of their latest PCMCIA modem driver software.

Notebook manufacturers often know the best way to configure 
PCMCIA cards to work with their notebooks. Check with your notebook 
manufacturer to see that your PCMCIA modem settings are correct.

Modem is not available

Situation: After using a DOS-based communications program, the modem is not 
available to Cyberjack.

Solution: Close the DOS-based communications program and exit DOS mode. 
Unless you exit DOS mode, the modem is not released.



Message: An essential file is missing. Reinstall the Dial-Up Networking Files.

Situation: This message may appear when trying to connect to the Internet.

Solution: Verify that your TCP/IP settings are correct. If these settings are 
correct, try connecting again. For more information on TCP/IP setup, 
click here .

Message: Authoritative Answer: Host Not Found. [Cancel, Retry, Ping]

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program.

Solution: Click Ping. If Cyberjack Ping returns “Host lookup failed”, the Cyberjack 
program is unable to locate the Internet site specified. Check that you 
have correctly spelled the address of the Internet site. If the spelling is 
correct, the Internet site no longer exists, or may be experiencing 
problems, or you may have lost your Internet connection.

If Cyberjack Ping returns “Host found”, exit Ping and click Retry.

Message: Connection closed by remote site. Do you want to reconnect? 
[Yes, No]

Situation: This message may appear while you are using any Cyberjack program.

Solution: The connection to the remote FTP site has been dropped. Click YES to 
reconnect to the FTP site.

Message: Connection Lost: Your connection to the server has been 
terminated.

Situation: This message appears if you try to initiate a Cyberjack News session 
and you do not have permission to access the News site.

Solution: Obtain the correct name of your of the News site from your service 
provider. This message often follows the “You have no permission to 
talk. Goodbye“ system message.

Message: Dial-Up networking could not negotiate a compatible set of 
network protocols you specified in the Server Type settings. 
Check your network configuration in the Control Panel then try the 
connection again.

 Situation: This message may appear when trying to connect to the Internet.

Solution: Check the settings for your Internet connection. If they are correct, try 
connecting to your service provider again. If you continue to have 
problems, contact your service provider.

Message: Disconnected



Situation: This message may appear when you are using a Cyberjack program 
and have connected to a site.

Solution: This is not an error message—the Cyberjack program is notifying you 
that all of the data from the Internet site has been transferred. You are 
still connected to your service provider.

Message: Error 403
Forbidden - bad user directory

Situation: This message may appear when trying to connect to a Web page and 
Cyberjack Web is unable to locate a Web page in the directory the 
address specified.

Solution: Check that you have correctly spelled the address of the Internet site. If 
you have the correct spelling, verify that the original reference for the 
Web address is correct.

Message: Error 404. Not found - file doesn’t exist or is read protected 

Situation: This message may appear when trying to connect to a Web page, 
Cyberjack Web is unable to locate a Web page at the address 
specified.

Solution: Check that you have correctly spelled the address of the Internet site. If 
you have the correct spelling, verify that the original reference for the 
Web address is correct.

Message: Fatal Error 500

Situation: This message may appear when trying to connect to a Web page.

Solution: The Internet site has encountered an unexpected condition which 
prevents it from processing the requested function within a Web page. It 
generally occurs when submitting a Web-based form.

Message: 403 Forbidden. Your client does not have permission to get URL 
[Web address] from this server.

Situation: This message may appear when trying to connect to a Web page.

Solution: The Web page you have requested exists, but you are not allowed to 
access it.

Message: 404 Not Found
The requested URL [Web address] was not found on this server.

Situation: This message may appear when trying to connect to a Web page.

Solution: Cyberjack Web is unable to locate a Web page at the address 
specified. Check that you have correctly spelled the address of the 



Internet site. If you have the correct spelling, verify that the original 
reference for the Web address is correct.

Message: If you are using a dial-up connection, make sure that your 
connection is established, then Retry. [Cancel, Retry, Ping]

Situation: This message may appear when you try to run a Cyberjack program 
before connecting to the Internet.

Solution: Click Cancel, then connect to the Internet.

If you have the Microsoft Plus Pack, ensure Use AutoDial is disabled 
under Internet in Control Panel. For more information see you Microsoft 
Windows documentation.

Message: Guidebook.gbk
Unable to register document.
The document may already be open.

Situation: This message may appear when you try to start the Cyberjack 
Guidebook and it is already running.

Solution: Only a single copy of Guidebook can run at any time. Check your 
Windows Taskbar for an open copy of the Guidebook if it is not 
displayed on your screen.

Message: Ninety percent or more of your system resources are in use. To 
free up system resources, quit any programs that you are not 
using. If you do not, your computer may stop responding.

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program and your system resources are low.

      Solution: To free up system resources, close any non-essential Windows 
programs on your computer.

Message: No such group.

Situation: This message may appear when trying to connect to a Newsgroup that 
does not exist.

Solution: In the Newsgroup Filter field, enter a word that you know is part of the 
name of the Newsgroup you are searching for. Cyberjack News 
displays all of the Newsgroups containing that word.

Message: Not Connected—[Cyberjack Program]

Situation: Appears in the title bar of a Cyberjack program when you are online.

Solution: This is not an error message — the Cyberjack program is awaiting an 
action.



Message: Non-Authoritative: Host not found, or SERVERFAIL. [Abort, Retry, 
Ping]

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program.

Solution: Click Ping. If Cyberjack Ping returns “Host lookup failed”, the Cyberjack 
program is unable to locate the Internet site specified. Check that you 
have correctly spelled the address of the Internet site. If the spelling is 
correct, try to connect to a different Internet site using another 
Cyberjack program. If you get the same result, your Internet service 
provider may be experiencing problems. Try to connect to your service 
provider later.

If Cyberjack Ping returns “Host found”, exit Cyberjack Ping and click 
Retry.

Message: Reestablish Connection — Connection to [name of Service 
provider] has terminated. Do you wish to reconnect? [Reconnect, 
Cancel]

Situation: This message appears when you are logged off of your service 
provider. 

Solution: One of three things has happened:

    your telephone line was noisy, which caused the connection to fail
    the connection disconnected due to call-waiting
    you were disconnected by your service provider.
Try reconnecting to your service provider. Your service provider may 
impose limits on the amount of time you can stay online. Check with your 
service provider if you cannot find any problems with your Internet 
connection settings. For more information on your connection setup, click 
here 

Message: Socket Receive Error. The Virtual Circuit was reset by the remote 
site. [OK]

Situation: This message appears when the remote Internet site disconnects you 
while using any Cyberjack program.

Solution: This is a normal occurrence when your Cyberjack program has been 
idle for an extended period of time while connected to a site. In some 
cases, it signals that there is a problem with the host site. It can also 
happen if your modem loses the connection. Click OK to try to 
reconnect with the site.

This message may appear differently in various Cyberjack programs.

Message: The specified address is not available from the local machine. 
[Abort, Retry, Ping]

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program.

Solution: Click Ping. If Cyberjack Ping returns “Host lookup failed”, the Cyberjack 



program is unable to locate the Internet site specified. Exit Cyberjack 
Ping and click Cancel.

If Cyberjack Ping returns “Host Found” and “Timeout on Ping”, either 
your service provider or the Internet site is experiencing problems. Exit 
Cyberjack Ping and click Cancel. Try connecting to a different Internet 
site using another Cyberjack program. If you get the same result, the 
problem probably resides with your service provider. Try to connect to 
your service provider later.

Message: The attempt to connect was forcefully rejected. [Abort, Retry, Ping]

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program.

Solution: Click Ping. If Cyberjack Ping returns “Host lookup failed”, the Cyberjack 
program is unable to locate the Internet site specified. Exit Cyberjack 
Ping and click Cancel.

If Cyberjack Ping returns “Host Found”, the Internet site is either 
experiencing problems, or does not support the type of connection you 
are trying to establish. Exit Cyberjack Ping and click Cancel.

Message: The attempt to connect was timed out without establishing a 
connection. [Abort, Retry, Ping]

Situation: This message may appear when trying to access an Internet site using 
any Cyberjack program.

Solution: Click Ping. If Cyberjack Ping returns “Host lookup failed”, the Cyberjack 
program is unable to locate the Internet site specified. Exit Cyberjack 
Ping and click Cancel.

If Cyberjack Ping returns “Host Found”, the Internet site is experiencing 
problems. Try to connect to your service provider later. Exit Cyberjack 
Ping and click Cancel. 

Message: The computer you are dialing in to is not answering. Try again 
later.

Situation: This message may appear when trying to dial up your service provider.

Solution: Ensure that the phone number for your Internet service provider is 
correct. 

This message also appears if you need access an outside line before 
you dial, and have not enabled this feature. For more information on 
configuring your Internet connection, click here 

The modem you dialed into at the service provider may be experiencing 
problems. Most service providers have multiple modems on their incoming 
phone line. Try to connect to your service provider again.

Message: The specified address family is not supported.



Situation: This message may appear while accessing an Internet site using any 
Cyberjack program.

Solution: This situation occurs when your TCP/IP settings are incorrect or when 
your service provider uses transmission protocols your dial-up 
connection does not support. For more information on correct TCP/IP 
setup, click here 

Message: The TCP/IP Protocol is not installed on your system.

Situation: This message may appear when trying to connect to the Internet.

Solution: This situation occurs when your TCP/IP settings are incorrect. For more 
information on correct TCP/IP setup, click here 

Message: There is no dial tone. Make sure your modem is connected to the 
phone line properly.

Situation: This message may appear when trying to connect to the Internet.

Solution: Check that the line running from your telephone line to the modem is in 
the correct outlet, and that the telephone line is working. When you 
have verified this, try connecting again.

Message: Unauthorized 401

Situation: This message may appear when trying to connect to a Web page that 
exists but you are not allowed access to it.

Solution: Access to the Web page is restricted to those with proper authorization. 
This can occur when a password is required, or access is granted only 
to users within certain domain names or country domains.

Message: You have no permission to talk. Goodbye.

Situation: This message may appear when trying to initiate a Cyberjack News 
session and you do not have permission to access the News site.

Solution: Obtain the correct name of the News site from your service provider. 

Checking system messages

This following is a list of some of the error messages you may encounter if you have problems using 
the Cyberjack programs. 

Many of these error messages report the quality and condition of your Internet connection, and do not 
reflect problems originating with Cyberjack.

 An essential file is missing. Reinstall the Dial Up Networking Files.

Authoritative Answer: Host Not Found. [Cancel, Retry, Ping]

Connection closed by remote site. Do you want to reconnect? [Yes, No]

Connection Lost: Your connection to the server has been terminated.



Dial-Up networking could not negotiate a compatible set of network 
protocols you specified in the Server Type settings. Check your network 
configuration in the Control Panel then try the connection again.

Disconnected

Error 403
Forbidden - bad user directory

Error 404. Not found - file doesn’t exist or is read protected

Fatal Error 500

403 Forbidden. Your client does not have permission to get URL [Web 
address] from this server.

404 Not Found
The requested URL [Web address] was not found on this server

If you are using a dial-up connection, make sure that your connection is 
established, then Retry. [Cancel, Retry, Ping]

Guidebook.gbk
Unable to register document.
The document may already be open.

Ninety percent or more of your system resources are in use. To free up 
system resources, quit any programs that you are not using. If you do not, 
your computer may stop responding.

No such group.

Not Connected—[Cyberjack Program].

Non-Authoritative: Host not found, or SERVERFAIL. [Abort, Retry, Ping]

Reestablish Connection — Connection to [name of Service provider] has 
terminated. Do you wish to reconnect? [Reconnect, Cancel]

Socket Receive Error. The Virtual Circuit was reset by the remote site. 
[OK]

The specified address is not available from the local machine. [Abort, 
Retry, Ping]

The attempt to connect was forcefully rejected. [Abort, Retry, Ping]

The attempt to connect was timed out without establishing a connection. 
[Abort, Retry, Ping]

The computer you are dialing in to is not answering. Try again later.

The specified address family is not supported.

The TCP/IP Protocol is not installed on your system.

There is no dial tone. Make sure your modem is connected to the phone 
line properly.

Unauthorized 401

You have no permission to talk. Goodbye.



Cyberjack Archie situations

Situation: Cyberjack Archie is unable to establish a successful connection with 
an Archie server.

Solution: The Archie server is probably busy. Try your Archie search again.

Cyberjack Finger situations

Situation: You use Cyberjack Finger on a site that you know exists. Cyberjack 
Finger disconnects after a few seconds and does not display any 
information about the Internet site.

Solution: Not all Internet sites support Finger access. If a site does not support 
Finger access, you cannot use Cyberjack Finger to get information 
about users at that site.

Cyberjack FTP situations

Situation: You cannot log onto an active FTP site.

Solution: The FTP site may be busy. Many FTP sites limit the number of 
users that can connect at any one time. Try your FTP connection 
again later.

Situation: When you drag files from Internet sites to your desktop for 
downloading, you cannot start any new Windows programs.

Solution: The Windows desktop is not capable of multi-threading, so it does 
not allow you to start any Windows program as files are being 
transferred to your desktop. To prevent this situation from 
occurring, do not drag files from an FTP site to your desktop.

Cyberjack IRC situations

Situation: Many people disappear from an active channel at once.

Solution: This situation occurs when an IRC server goes down. This is known 
as a “netsplit”. For more information click here 

Cyberjack Web situations

Situation: You have changed the color of the fonts in Cyberjack setup. Some 
of the Web pages you view do not reflect these changes.

Solution: Some Web pages set the color for their text within the code of the 
page. To ensure readability, Cyberjack Web does not try to change 
the colors set by the site.



Cyberjack Guidebook situations

Situation: You are uninstalling Cyberjack and want to make a back-up copy of 
your Guidebook to retain the CyberLinks of the Internet sites you 
have alreadyvisited.

Solution: There are two methods you can use to make back-up copies of 
your Cyberjack Guidebook. They are:

 Export the Guidebook as an HTM or TXT file and import it 
back again. To export the Guidebook, click here . To import the 
Guidebook back again, click here .
 Find the GUIDEBOOK.GBK file and copy it to another folder 
on your computer. To import this back-up copy of the Guidebook, 
double click the GUIDEBOOK.GBK file. The Cyberjack Guidebook 
window opens, and a link is automatically made to the GBK file.

CompuServe situations

Situation: After configuring CompuServe Mail with the Delrina Internet Mail 
Transport under MS Exchange, you get the following message:

Please make sure your connection is established, then Retry 
and verify your POP3 domain name.

Solution: Do the following:

1. Click the Windows Start button, point to Settings, and click 
Control Panel. The Control Panel window opens.

2. Click Mail and Fax. The MS Exchange Settings Properties 
dialog appears.

3. Click Delrina Internet Mail Transport, and click Properties. The 
Delrina Internet Mail Transport Properties dialog box appears.

4. Click the Account tab, and do the following:

 In the Email address field, type the address given to you by 
CompuServe.
 In the Email username field, type the user name given to you 
by CompuServe.
 In the Email password field, type the Email password given to 
you by CompuServe.

5. Click the Host tab, and do one of the following:

If you have a CompuServe account that was created through 
Cyberjack, do the following:

In the SMTP HOST field, type ...
delrinamail.interserv.net

In the POP3 Host field, type ...
delrinamail.interserv.net

OR

If you have a previous CompuServe account that was not 
created through Cyberjack, do the following:

 In the SMTP Host field, type ...



relay.interserv.com
 In the POP3 Host field, type ...

m1.interserv.com ... 
... or ...
m2.interserv.com ... 
... or ...
m3.interserv.com

6. Click the General tab.

7. In the User field, type your name.

8. In the Delivery mode section, enable one of the options.

Notes

 If you have questions regarding the POP3 setting, contact 
InterServ Technical Support at (206) 957-8997.
 If you have configured everything properly, and you are able 
to receive but not send email, the SMTP server may be temporarily 
out of service. Try again later.

Integrating Cyberjack with Netscape Navigator

If you use Netscape Navigator as your Web browser, you can integrate it with Cyberjack to take advantage of the 
complete Cyberjack suite of Internet tools. For example, if you double click a Gopher site address while browsing 
with Netscape Navigator, Cyberjack Gopher starts and connects to the site.

To integrate Cyberjack with Netscape Navigator:

1. Enable the Cyberjack programs you want to use with Netscape Navigator.

2. Click Finish.

If you do not want to integrate Cyberjack with Netscape Navigator, click Cancel.

Notes

If you want to start Netscape Navigator when you click a Web CyberLink in the Guidebook, you must 
uninstall Cyberjack Web. If Netscape Navigator is not your default Web browser, then the default Web browser you 
have selected will start. To uninstall programs, see your Microsoft Windows 95 documentation.

If you experience problems integrating with Netscape Navigator or using any of the Cyberjack programs with 
Navigator, make sure you are running the latest version of Netscape Navigator. You can download the latest version 
of Netscape Navigator by connecting to the following Web site:

http://home.netscape.com/





Cyberjack Glossary

Click the first letter of the word you want defined.

A
 Acceptable Use Policy (AUP)
 account
 address
 .AIF (.AIFF)
 American National Standards Institute (ANSI)
 American Standard Code for Information Interchange (ASCII)
 anonymous FTP
 ANSI
 application
 .ARC
 Archie
 archive
 .ARJ
 article
 ASCII
 Asynchronous Transfer Mode (ATM)
 ATM
 attachment
 .AU (.SND)
 AUP
 .AVI

B
 backbone
 ban
 bandwidth
 .BAT
 binary file
 Binhex
 bitmap
 .BMP
 bookmark
 bounce
 browsing

C
 cache
 case sensitive
 channel
 channel operator
 character
 client
 Client to Client Protocol (CTCP)
 .CMPl



 .CNT
 .COM
 compression
 connection
 CTCP
 CyberLink
 cyberspace
 Cyberwizard

D
 DCC
 dialup
 Direct Client to Client (DCC)
 .DNS
 .DOC
 domain name
 Domain Name Server (DNS)
 download
 .DPX
 drag and drop

E
 echo
 electronic mail
 email
 emoticon
 encode
 .EPS
 ethernet
 exact match
 .EXE
 extension

F
 FAQ
 FDDI
 Fiber Distributed Data Interface (FDDI)
 file extension
 File Transfer Protocol (FTP)
 filter
 finger
 firewall
 flame
 flooding
 forum
 freenet
 Frequently Asked Questions (FAQ)
 FTP
 .FXS

G
 gateway
 .GIF
 Gopher



 Gopher+
 gopherspace
 .GZ

H
 header
 .HLP
 home page
 host
 host system
 .HQX
 .HTM
 HTML
 HTTP
 hypertext
 HyperText Markup Language (HTML)
 HyperText Transport Protocol (HTTP)

I
 icon
 Image Viewer
 .IMG
 Integrated Services Digital Network (ISDN)
 Internet
 Internet address
 Internet Protocol (IP)
 Internet Relay Chat (InternetRelayChat)
 Internet service provider
 IP
 IP address
 IRC
 ISDN

J
 .JFIF
 .JPEG (.JPG)
 Jughead

K
 kick
 kill

L
 lag
 LAN
 leased-line
 .LHA (.LZH)
 LISTSERV
 Local Area Network (LAN)
 log on (or log in)
 lurk

M



 macro
 mailing list
 Message of the Day (MOTD)
 MIME
 .MOD
 modem
 MOTD
 .MPEG (.MPG)
 .MSP
 Multi-Purpose Internet Mail Extensions (MIME)

N
 netiquette
 netsplit
 network
 newsgroup
 nickname
 null channel

O
 Object Linking and Embedding (OLE)
 offline
 OLE
 online
 op

P
 Packet Internet Groper (Ping)
 packet switching
 .PCD
 .PCT
 .PCX
 .PDF
 Ping
 Point-to-Point Protocol (PPP)
 POP
 post
 Post Office Protocol (POP)
 .POV
 PPP
 .PPT
 program
 protocol
 proxy
 .PS

Q
 .QT

R
 .RAM
 .RAS
 refresh



 REGEX
 regular expression (REGEX)
 reload
 remote access
 remote login
 remote system
 Rich Text Format (RTF)
 right click
 right-click menu
 Rotate 13
 route
 router
 RTF

S
 .SEA
 Serial Line Internet Protocol (SLIP)
 server
 service provider
 session
 signature file
 Simple Mail Transfer Protocol (SMTP)
 .SIT
 site
 SLIP
 smiley
 SMTP
 .SND
 socket
 SOCKS
 spamming
 surf

T
 .TAR, .TAR.Z, .TAR.GZ
 TCP
 telnet
 terminal
 terminal display
 terminal emulation
 .TGA
 .TIF
 toolbar
 Transmission Control Protocol/Internet Protocol (TCP/IP)
 .TSP
 .TXT%TXT>Glossary

U
 Universal Resource Locator (URL)
 UNIX
 upload
 URL
 Usenet
 uuencode



V
 Veronica
 virus
 .VOC

W
 WAIS
 WAN
 .WAV
 wave file
 Web page
 Wide Area Information Servers (WAIS)
 Wide Area Network (WAN)
 wildcard
 Winsock
 wizard
 WWW
 World Wide Web (WWW or Web)
 .WPD
 .WPG
 .WRI

X
 .XBM
 .XLS

Y
There are no glossary terms beginning with the letter “Y”.

Z
 .Z
 .ZIP
 Zip Manager
 .ZOO



address

See Internet address, IP address or Universal Resourse Locator (URL)



American National Standards Institute (ANSI)

The principal standards development organization in the United States. ANSI provides standards for 
communication software.



article

A message posted to a newsgroup. Articles can also contain encoded files that you can decode and 
download.



application

See program.



American Standard Code for Information Interchange (ASCII)

An abbreviation for American Standard Code for Information Interchange. This standard code consists 
of 7 data bits (or binary values) per character. Letters, numbers, and special characters (for example, 
$,ÿ,#, %) are represented by different ASCII codes. The ASCII character set represents 96 printable 
characters and 32 non-printable control characters.



ban

In IRC, to kick a user off a channel and prevent them from re-entering.



binary file

A file that contains characters other than the standard ASCII characters. Binary files cannot be read 
like text files; they are usually executable programs or compressed files.



.BMP

Windows bitmap graphics format file.



bookmark

See CyberLink.



cache

A section of memory reserved for recently accessed information, used to speed-up subsequent 
accesses for the same information.



case sensitive

When you connect to the Internet using names, addresses or search words, you must type the letters 
in their proper case (upper or lower).



channel operator

An IRC user who has special privileges on a channel, including the right to kick users off the channel, 
change channel modes, and make other users channel operators. Also known as chanops.



character

A standard 8-bit unit representing a symbol or letter. Also known as a byte.



Client to Client Protocol (CTCP)

An IRC protocol that allows the exchange of structured data and query information. CTCP commands 
supported by Cyberjack IRC include VERSION, FINGER, PING, CLIENTINFO, DCC, ACTION and 
ECHO.



compression

The process of reducing the total size of a file by converting it to a more compact format. Many files on 
the Internet are compressed to reduce the amount of time needed to transfer them to your computer.



crosspost

Posting a news article to two or more related newsgroups.



CyberLink

A Cyberjack bookmark object that as acts a direct shortcut to an Internet site. You can create 
CyberLinks to your favorite sites, and send them to other users through email. Also, any URL you can 
takes you to another site when you double click it is also a CyberLink.



cyberspace

Term originated by author William Gibson in his novel Neuromancer, the word Cyberspace is currently 
used to describe the whole range of information resources available through computer networks.



Cyberwizard

Cyberjack’s main wizard, which helps you get connected to Internet sites.



wizard

Each Cyberjack program consists of a wizard to help you connect to a resource on the Internet.



dialup

A temporary connection between computers established over a telephone line using modems.



Direct Client to Client (DCC)

An IRC protocol that allows users to chat privately, and send and receive files directly, bypassing IRC 
servers. DCC chats cannot be monitored by IRC server operators.



download

The process of receiving a file from another computer. Contrast with upload.



drag and drop

The action of moving a file from one location on a desktop to another by selecting the file, and 
dragging it to a new location. You can drag and drop files to in several Cyberjack programs to 
automate file transfers.



echo

The process whereby a computer sends back a duplicate of each received character to the computer 
that sent the character. In communications with most remote, dial-up systems, characters you type on 
your keyboard will be echoed back to you by the remote system. Similarly, Cyberjack Ping operates by 
sending out packets of data, and “listens” for their echo.



electronic mail (email)

See email.



emoticon

See smiley.



encode

See uuencode.



extension

See file extension.



exact match

A type of search used to find names of files and folders that exactly match your search word.



flooding

To send excessive amounts of text to an IRC channel. Many channel operators kick users for flooding. 
Also, if too many demands are placed by the user on the server, as when generating channel lists, the 
server typically removes the user from the server.



filter

In News, a program that allows you to display newsgroup names containing a specified keyword, or 
filter word. When you type a word into the Filter field, only newsgroups that contain that word appear in 
the list.



file extension

The end portion of a file name, after the last dot, indicating the kind of data stored in the file. For 
example, the file name resume.txt is an ASCII text file.



flame

A hostile newsgroup article that insults, provokes or rebukes a particular subject or another article 
author. Also, the act of posting such an article. Ongoing replies to the same subject are known as 
flame wars, and an article that is sure to invoke a flame is known as flame bait.



forum

An online discussion group, including BBSs, mailing lists or newsgroups. Contrast to real-time chat 
(IRC) or email.



Gopher+

An enhanced Gopher protocol that provides file details such as addresses, phone numbers and other 
information.



gopherspace

A collective term for the network of connected Gopher sites.



header

Information that precedes a newsgroup article, which contains information about the article including 
the author’s name and email address, the date and time the message was sent, and to which 
newsgroups the article was posted.



host system

A computer or computer service (other than the one on which you are running Cyberjack) with which 
you can establish a connection and exchange data. It accepts calls and responds to commands that 
the caller types on a terminal or on a computer that is acting as a terminal. Sometimes known as 
Remote system.



icon

A “picture” that is a graphical representation of various Windows elements.



Integrated Services Digital Network (ISDN)

Integrated Services Digital Network (ISDN) is a digital transmission technology that enables voice and 
high-speed data communications on a single telephone line.



Internet

An “internet” (lowercase i) is a collection of networks linked by a set of routers which allow them to 
function as a single, large virtual network. The Internet (uppercase I) is the largest internet in the world 
made up of large national backbone nets as well as regional and local campus networks all over the 
world.



Internet service provider

See service provider.



Joint Photographic Experts Group (JPEG)

A standard for lossy graphics file compression.



kick

To remove an IRC user from the current channel. Only channel operators can kick users off a channel.



kill

To remove an IRC user from a server. Only server operators can kill users from a server.



lag

In IRC, the time difference between when a user sends a message and when the message is received



log on (or logon)

Log on is an action, meaning to type a user identification and password as necessary to gain access to 
a computer system. Logon describes the activity of logging on or the information you type when 
logging on.



lurk

When a Newsgroup or IRC user does not participate in the discussions.



macro

An automatic sequence that issues multiple keystrokes or characters when you enter a single 
keystroke or key combination.



Message of the Day (MOTD)

In IRC, a message that appears when a user connects to a server. The MOTD usually contains 
information about the server, the current number of users and channels, and the server’s rules.



modem

A device used to convert computer data (digital format) into a form (analog format) that can travel 
through telephone lines. It is an abbreviation for MOdulator - DEModulator.



network

A computer system in which resources are shared among multiple computers.



Object Linking and Embedding (OLE)

A technology developed by Microsoft to allow Windows users to incorporate text and objects from 
other programs into their current document. For more information, refer to your Microsoft Windows 95 
documentation.



offline

A term describing a computer that is not connected to another for the purpose of communications. 
Contrast with online.



online

A term for being connected with a remote computer for purposes of communications. Contrast with 
offline.



op

To grant channel operator status to another user on IRC. To de-op someone is to remove their channel 
operator status.



password

A word or group of characters a user has to enter to gain access to a computer, system or files.



protocol

A system of rules and procedures governing communications between two or more devices. Protocols 
vary, but communicating devices must follow the same protocol in order to exchange data. The format 
of the data, readiness to receive or send, error detection, and error correction are some of the 
operations that may be defined in protocols.



remote access

The ability of a computer in one location to reach a computer at a different location. The most common 
methods of remote access are through a network or by modem.



remote system

A computer or computer service with which you can establish a connection and exchange data. It 
accepts calls and responds to commands that the caller types on a terminal or on a computer that is 
acting as a terminal. Sometimes known as host system.



regular expression (REGEX)

A type of search used to find patterns in names of files and folders.



REGEX

See regular expression.



Rotate 13

An encryption program for news articles where every letter is replaced by the one 13 positions to the 
left. For example, “a” is replaced by “m”, “b” by “n” and so on. Authors of newsgroup articles use 
Rotate 13 if the subject of their article is potentially offensive, or if they are posting information that 
some readers may not want to see, like the solution to a puzzle or the ending of a movie.



session

One instance of a connection to a remote system.



terminal display

The terminal display is the portion of the session window where interaction with the remote system 
takes place. By default, the terminal area is surrounded by a frame.



terminal

A computer monitor and keyboard used to access a remote computer.



terminal emulation

The ability of a personal computer to simulate a remote terminal.



TIFF

Graphics file format.



upload

To upload is to send a file to another computer. Contrast with download.



virus

A destructive, self-replicating program. Viruses often disguise themselves by embedding in program 
executables. Some viruses are harmless, while others are quite destructive.



Winsock

Short for Windows Sockets. A TCP/IP stack used by Windows to communicate with a network.



Zip Manager

A Cyberjack and WinComm file compression and decompression utility.



attachment

A file that is sent as a message or as a component of a message. An attachment can be an image or a 
binary file. Attachments may be created in Windows programs.



bitmap

An image formed by patterns of small screen dots (pixels).



ethernet

A local area network standard originally designed by Xerox. Ethernet transfers data at a rate of 10 
megabits per second using a baseband communication method.



Image Viewer

A Cyberjack component that allows images to be previewed while downloading.



Local Area Network (LAN)

Computers and devices connected together to share information and hardware within a limited area, 
usually a single building.



email

Messages sent from one computer to another through telephone lines or a local area network (LAN). 
Sometimes called electronic mail. 



program

A computer application you interact with or use to perform a task or function, such as word processing, 
spreadsheet, accounting, electronic mail or Internet software.



Rich Text Format (RTF)

A file format that defines formatting instructions for a document.



right click

To click the right mouse button.



right-click menu

A context-sensitive menu in Cyberjack displayed by placing the mouse pointer on a particular area of 
the screen and clicking the right mouse button.



reload

To update the current window display. In some cases, new data may appear.



site

A computer attached to the Internet which provides a service so that you can log on to and make 
requests.



signature file

Information about a user that appears at the end of a news article or email. Most signature files include 
the user’s real name and email address, favorite quotes, Web page address, and an ASCII picture. 
Signature files should be kept to a maximum of four lines to conserve bandwidth.



socket

A pairing of an IP address and a port number.



SOCKS

A security package that allows a host behind a firewall to maintain security while using external finger, 
FTP, Telnet and Gopher, resources.



spamming

A popular term for the act of flooding newsgroups with irrelevant or inappropriate messages in 
deliberate violation of netiquette. Spamming includes posting advertisements and crossposting an 
article to a large number of newsgroups.



surf

To randomly browse various Internet sites. Most commonly associated with going from one Web page 
to another.



TIFF

Tagged Image File Format. A bitmapped graphic format used for images.



toolbar

A screen component used to display command icons which activate menu commands, or tool icons 
which activate individual tools.



wave file

Sound files with the extension .WAV. In Cyberjack, you can use a .WAV file to notify you when you 
receive a fax.



Acceptable Use Policy (AUP)

A service provider's policy statement regulating permissible network activities. A publicly accessible 
service provider may restrict network use against commercial activities.



account

An arrangement made between a user and a service provider for access to the Internet. The user 
agrees to follow the service provider's Acceptable Use Policy (AUP) and pay the rate for accessing 
their resources.



Archie

A system which provides lists of anonymous FTP files, or a group of files stored under one file name. 
Also used as a term to describe a server containing files available for downloading via FTP.



archive

A directory of stored files, or a group of files that have been compressed into one file.



Asynchronous Transfer Mode (ATM)

A networking standard for packet switching. Technique which uses packets of fixed length.



anonymous FTP

See File Transfer Protocol (FTP)



backbone

A high-speed line or series of connections forming a major pathway within a network. A backbone in a 
small network will likely be much smaller than many non-backbone lines in a large network. The term 
is also used to refer to a system that acts as a center for Internet activity.



bandwidth

Maximum transfer rate within the physical constraints of media, file size, speed and other overhead 
involved with data transfer.



Binhex

BINary HEXadecimal. A method for converting non-text files (non-ASCII) into ASCII. This is needed 
because Internet email can only handle ASCII. Files using this process are typically called binaries.



bounce

To return after a failed delivery attempt. If email cannot reach its intended destination, it is returned to 
the originator of the message.



browsing

A method of searching for information on the Internet, specifically in Web and Gopher.



channel

The basic unit of discussion on IRC. After joining a channel, everything you type is read by others on 
that channel. Channels can either be named with numbers or with strings beginning with a “#” sign, 
and can have topic descriptions.



client

A software program used to contact and make requests from a server software program on another 
computer. Each client program is designed to work with one or more specific kinds of server programs.



connection

A physical link that supports communication between two computers.



domain name

A naming hierarchy for administrative partitioning of a complex distributed system.



Domain Name Server (DNS)

A general-purpose data query service used on the Internet for translating hostnames into Internet 
addresses.



Fiber Distributed Data Interface (FDDI)

A 100 megabytes per second network protocol that transports data using a fiber optic medium.



File Transfer Protocol (FTP)

The Internet protocol and program used to transfer data between sites.



Finger

An Internet software tool for locating people on other Internet sites. Finger can also be used to give 
access to non-personal information, but the most common use is to see if a person has an account at 
a particular Internet site. It typically shows full name, last login time, idle time, terminal line, and 
terminal location.



firewall

A host designed to prevent unauthorized entry to a network. Protected networks are connected to the 
Internet through a computer with two separate network adapters. The first adapter accesses the 
protected network, and the second adapter accesses the Internet. In order for anyone to get from the 
Internet to the protected network, they must pass through this computer.



freenet

A community based Internet host designed to bring free networking access to a community.



Frequently Asked Questions (FAQ)

Online documents that list and answer the most common questions on a particular subject or about a 
particular newsgroup. FAQs are usually maintained so that the participants in a newsgroup will not 
spend time answering the same set of questions.



gateway

An IP router that transfers data between normally incompatible programs or networks. It reformats data 
so that it is acceptable for the receiving network.



Gopher

A distributed document delivery system that allows users to browse for data residing on multiple hosts, 
WAIS databases, and phone books.



host

Any computer on a network that is a repository for services available to other computers on the 
network. It is quite common to have one host machine provide several services, such as WWW and 
newsgroups.



hypertext

A point-and-click graphical user interface similar to Windows Help. Generally, hypertext is any text that 
contains links to other documents, or the words or phrases in the document that can be chosen by a 
reader and which cause another document to be retrieved and displayed.



HyperText Markup Language (HTML)

The coding language used to create HyperText documents for use on the World Wide Web. HTML 
resembles traditional typesetting code, where blocks of text are surrounded by codes indicating how it 
should appear. HTML documents can contain graphics, rich text, sound, video and links to other HTML 
documents around the world.



HyperText Transport Protocol (HTTP)

The protocol for moving hypertext files across the Internet. Requires an HTTP client program on one 
end, and an HTTP server program on the other end. HTTP is the protocol used by the World Wide 
Web (WWW).



Internet address

An address assigned to hosts using TCP/IP, for example: user@host.domain.organization. The 
address, from left to right, moves from the name of the specific user to the code for the organization to 
which the user belongs.



Internet Protocol (IP)

The protocol used in gateways to connect networks to the Internet.



Internet Relay Chat (IRC)

A protocol that allows multiple users with Internet connections to “chat” with each other simultaneously 
in real time.



IP address

A set of four numbers separated by dots (for example, 199.85.126.251) that makes up an Internet 
address.



Jughead

A Gopher client that searches titles of Gopher folders. Jughead does not search resource titles.



leased-line

A permanent telephone line that links an Internet host to a service provider.



listserv

A mailing list program that automatically distributes messages to subscribers.



mailing list

An email discussion group. Contributions are sent to the list manager, who forwards the messages to 
other subscribers.



Multi-Purpose Internet Mail Extensions (MIME)

A protocol for sending multimedia email messages, PostScript formatting, sound files, graphics and 
digital video. The present Simple Mail Transfer Protocol transfers only plain text, including binary file 
attachments, which are changed to ASCII text.



netiquette

Network etiquette, an informal set of guidelines for using Internet programs. Proper Internet behavior 
includes conserving bandwidth, reading FAQs to keep up with recent changes, respecting the other 
users' opinions and staying on topic with group discussions.



newsgroup

A discussion forum made up of messages addressed to a specific newsgroup rather than individuals.



nickname

A name by which IRC users identify themselves in a channel.



null channel

In IRC, you are in the null channel when you are connected to the server, but not in any channel. You 
can still send and receive private messages, check the properties of other users, query the server for 
information and join new channels.



netsplit

In IRC, when a connection fails between two IRC servers. Netsplits usually occur when there is a 
problem with the physical connection between two servers, or if the server computer crashes, 
becomes overloaded or is rerouted by a server operator.



Packet Internet Groper (Ping)

A program used to test the accessibility of destinations by sending them an echo request and waiting 
for a reply.



packet switching

The process whereby a message is broken down into separate blocks of information, or packets, each 
containing the destination address. Each packet travels independently on different routes along the 
Internet, taking the most available route to the final destination, where they reassemble to form the 
original message.



Point-to-Point Protocol (PPP)

An Internet protocol for dialup IP access that links a personal computer to an Internet host through the 
telephone system and a high-speed modem.



post

To send a message to a mailing list or newsgroup.



Post Office Protocol (POP)

A protocol that handles mail for single-user machines. The POP stores and downloads incoming mail 
to the user's computer.



proxy

A server which opens a socket on a firewall , and allows communication to the Internet via the socket.



remote logon

To connect to a computer at a different location, usually through a network or modem.



route

The path data takes in reaching its destination.



router

A network device that examines the network address within a given protocol, determines the most 
efficient pathway to the destination, and routes the data accordingly.



Serial Line Internet Protocol (SLIP)

An Internet protocol that uses phone lines to connect systems, establishing a temporary, direct 
connection to the Internet where packets of data can travel back and forth.



Simple Mail Transfer Protocol (SMTP)

An Internet electronic mail protocol.



server

A program that receives requests for information from a client program, locates the information and 
sends it back to the client.



service provider

A commercial service equipped to offer a variety of Internet services. Access to a service provider is 
most commonly gained through a modem.



smiley

A method of showing emotion by using keyboard characters, also known as emotions. The following 
are examples of smileys:

:-) [happy]

:-( [sad]



telnet

A terminal protocol that allows users of one host to log on to remote hosts and perform as normal 
terminal users of that host.



Transmission Control Protocol/Internet Protocol (TCP/IP)

The main communications protocol in the Internet suite of protocols that provides reliable, connection-
oriented, full duplex streams and uses IP for delivery.



Universal Resource Locator (URL)

A pointer to remote sources on the Internet.



UNIX

An operating system originally developed by AT&T. Much of the Internet is UNIX-based.



Usenet

A collection of thousands of topically named newsgroups, the computers which run the protocols, and 
the people who read and submit Usenet news. Not all Internet hosts subscribe to Usenet, and not all 
Usenet hosts are on the Internet.



uuencode

A UNIX program for encoding binary data as ASCII. Uuencode is used to send files by email and to 
post files to newsgroups. The program decodes the file and recreates it in its original form.



Veronica

A program that searches for directory and file names found in Gopher sites.



Wide Area Information Servers (WAIS)

A system allowing users to search for words within files.



Wildcard

Matches any character in that position and all other positions that follow it.



Wide Area Network (WAN)

A network capable of covering a region larger than a metropolitan area.



World Wide Web (WWW or Web)

An easy but powerful graphical global information system based on a combination of information 
retrieval and hypertext techniques.



Web page

A World Wide Web hypertext page that appears when you access a site with a WWW client. Some 
home pages provide links to other home pages, navigation tools, files and other Internet sites.



.BAT

Batch file, can be MS-DOS or UNIX in origin.



.COM

Command file, usually an MS-DOS file.



.EXE

Executable DOS/Windows program. Can also be a compressed, self-extracting MS-DOS executable.



.AIF (.AIFF)

Macintosh sound file.



.AU (.SND)

Sun Microsystems/NeXT sound file format.



.MOD

Amiga sound file.



.RAM

RealAudio sound file.



.SND

See .AU.



.TSP

TrueSpeech sound file.



.VOC

SoundBlaster sound file.



.WAV

Microsoft sound file. See also wave file.



.DOC

Micosoft Word document file. Can also be an ASCII text file.



.CNT

Windows Help contents file. Usually associated with a .HLP file.



.HLP

Windows Help file. Usually associated with a .CNT file.



.HTM

Hypertext Markup file. This file type can be read directly by Cyberjack Web.



.PPT

Microsoft PowerPoint file.



.TXT

ASCII text file. This file type can be read directly by Cyberjack Web.



.WPD

WordPerfect document file.



.WRI

Microsoft Write text file.



.XLS

Microsoft Excel spreadsheet file.



.AVI

Microsoft Windows movie file.



.CMP

LEAD image file. This file format is supported by Image Manager.



.EPS

Encapsulated PostScript file. This file format is supported by Image Manager.



.DPX

Digital Moving Picture Exchange movie file.



.FXS

Delrina WinFax image file. This file format is supported by Image Manager.



.GIF

Graphic Interchange Format image file. This file type can be read directly by Cyberjack Web, and is 
supported by Image Manager.



.IMG

GEM image file. This file format is supported by Image Manager.



.JFIF

JPEG File Interchange Format image file. This file format is supported by Image Manager.



.JPEG (.JPG)

JPEG image file. This file type can be read directly by Cyberjack Web, and is supported by Image 
Manager.



.MSP

Microsoft Paint file. This file format is supported by Image Manager.



.MPEG (.MPG)

Motion Pictures Engineering group movie file.



.PCD

Photo CD image file. This file format is supported by Image Manager.



.PCT

Macintosh PICTURE file. This file format is supported by Image Manager.

.PCX

PC Paintbrush image file. This file format is supported by Image Manager



.PDF

Adobe Acrobat image file.



.POV

Persistence of Vision raytracing file.



.PS

PostScript file.



.QT

QuickTime movie file.



.RAS

Sun Microsystems raster image file.



.TIF

Tagged Image File image file. This file type can be read directly by Cyberjack Web, and is supported 
by Image Manager.



.TGA

Truevision (Targa) file. This file format is supported by Image Manager.



.WPG

WordPerfect Graphics Metafile.



.XBM

UNIX X-windows bitmap file. This file format is supported by Image Manager.



.ARC

ARC compressed file.



.ARJ

ARJ compressed file.



.GZ

GZIP compressed file.



.HQX

Macintosh BinHex file.



.LHA (.LZH)

LHARC compression file.



.SEA

Macintosh self-extracting archive file.



.SIT

STUFFIT for Macintosh compressed file.



.TAR,.TAR.Z, TAR.GZ

.TAR is a UNIX TAR archive.

.TAR.Z is a UNIX TAR archive file that has been UNIX COMPRESSed.

.TAR.GZ is a UNIX TAR archive file that has been compressed using GZIP.



.Z

UNIX COMPRESS file. 



.ZIP

PKZIP compressed file.



.ZOO

ZOO compressed file.







The protocol for moving hypertext files across the Internet. Requires an HTTP client program on one end, and an 
HTTP server program on the other end. HTTP is the protocol used by the World Wide Web (WWW).



The main communications protocol in the Internet suite of protocols that provides reliable, connection-oriented, full 
duplex streams and uses IP for delivery.



Action messages are brief descriptions of what you want the other users to picture you doing. For example, if 
another user says something funny, you might post the action message “Raven giggles”. Action message are 
automatically preceded by your nickname, so write your action in the third person. For example:

*Raven waves hello to everyone



Private action messages are sent only to the specified user, preceded by your nickname. For example:

*> Raven winks at you secretly ...

Your nickname does not appear in the Action field, but it will be the first word of your action message.



Points to a specific Web site.



A file that contains characters other than the standard ASCIIcharacters. Binary files cannot be read like text files; 
they are usually executable programs or compressed files.



An abbreviation for American Standard Code for Information Interchange. This standard code consists of 7 data 
bits (or binary values) per character. Letters, numbers, and special characters (for example, $,ÿ,#, %) are 
represented by different ASCII codes. The ASCII character set represents 96 printable characters and 32 non-
printable control characters.



A Cyberjack bookmark object that as acts a direct shortcut to an Internet site. You can create CyberLinks to your 
favorite sites, and send them to other users through email. Also, any URL you can takes you to another site when 
you double click it is also a CyberLink.



Hypertext Markup file. This file type can be read directly by Cyberjack Web.



A pointer to remote sources on the Internet.



Control the way you search by selecting Exact, Case Sensitive, Case Insensitive or Regular Expression.



When lurking, you are watching the chat to learn more information about the terms and expressions used in the 
chat.






